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Chapter 1 – Introduction 

Introduction 

spMats is for analysis and design of concrete foundation mats, combined footings, and slabs on grade. The 

slab is modeled as an assemblage of rectangular finite elements. The boundary conditions may be the 

underlying soil, nodal springs, piles, or translational and rotational nodal restraints. Slaved degrees of 

freedom may also be applied to selected nodes. The model is analyzed under static loads that may consist of 

uniform (surface) and concentrated loads. The resulting deflections, internal forces, soil pressure, and 

reactions are output. In addition, the program computes the required area of reinforcing steel in the slab. The 

program also performs punching shear calculations around columns and piles.  

spMats uses the thin plate-bending theory and the Finite Element Method (FEM) to model the behavior of the 

mat or slab. The soil supporting the slab is assumed to behave as a set of unidirectional (compression-only) 

translational springs (Winkler foundation). During the analysis, if loading/support conditions or the mat shape 

causes any uplift and induces tension in a spring, the spring is automatically removed. The mat is re-analyzed 

without that or any other tension spring. The program automatically iterates until all tension springs are 

removed and equilibrium is reached. 

Program Features 

 Support for ACI 318-14/11/08/05/02 and CSA A23.3-14/04/94 design standards 

 Export of mat plan to DXF files for easier integration with drafting and modeling software 

 Import of grid, load, and load combination information from text files to facilitate model generation 

 Four-noded, prismatic, thin plate element with three degrees-of-freedom per node  

 Material properties (concrete and reinforcing steel) may vary from element to element  

 Soil may be applied uniformly over elements or concentrated and applied at nodes using nodal spring 

supports 

 Default definitions and assignment of model properties are provided to facilitate model generation 

 Nodes may be restrained for vertical displacement and/or rotation about X and Y axes 

 Nodes may be slaved to share the same displacement and/or rotation  

 Loads may be uniform (vertical force per unit area) or concentrated (Pz, Mx, and My)  

 Load combinations are categorized into service (serviceability) and ultimate (design) levels  

 The self-weight of the slab is automatically computed and may optionally be included in the analysis  

 Result envelopes (maximum and minimum values) for deflections, pressures, and moments  

 Design moments include contribution of twisting moments via Wood-Armer formulas 

 Punching shear calculations for rectangular and circular columns are performed 

 Fast graphical interface that displays the modeled mesh at all times for verification  

 Graphical image displays of node and element numbers, grid lines, and slab boundaries  

 Ability to zoom and translate (pan) the graphical image  

 Isometric (3D) view of the modeled slab with ability to rotate using the mouse  
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 Contour plots to visualize results of analysis and design 

 U.S. Customary or SI (metric) units  

 Context sensitive help 

 Checking of data as they are input  

 User-controlled screen color settings  

 Ability to save defaults and settings for future input sessions 

Program Capacity 

 255 X-grid lines  

 255 Y-grid lines  

 255 Thickness definitions  

 255 Concrete definitions  

 255 Soil definitions  

 255 Nodal spring definitions  

 255 Slaved nodes definitions  

 255 Pile definitions  

 26 Load cases 

 255 Concentrated load definitions per load case  

 255 Surface load definitions per load case  

 255 Load combinations (service plus ultimate) 

 65,025 nodes and 64,516 elements  

NOTE: Actual program capacity depends on system resources available on the computer on which spMats is 

running. To solve models with the maximum number of nodes and load combinations, a 64-bit operating 

system with at least 8GB of RAM is recommended. 

System Requirements 

spMats is a 32-bit Windows application. spMats solver has a 32-bit and a 64-bit version. The proper version 

is selected automatically by the installation program based on the target computer architecture. Any computer 

running Microsoft Windows XP, Windows Vista, Windows 7, or Windows 8 operating system is sufficient to 

run the spMats program provided that .NET Framework v4 is installed. If it is not detected by the installation 

program then it will be installed automatically. 

For instructions on how to troubleshoot system specific installation and licensing issues, please refer to 

support pages on the StructurePoint website at www.StructurePoint.org. 

Terms 

The following terms are used throughout this manual. A brief explanation is given to help familiarize you 

with them. 

Windows Refers to the Microsoft Windows environment as listed in System Requirements. 

[ ] Indicates metric equivalent. 

http://www.structurepoint.org/
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Click on Means to position the cursor on top of a designated item or location and press and 

release the left-mouse button (unless instructed to use the right-mouse button). 

Double-click on Means to position the cursor on top of a designated item or location and press and 

release the left-mouse button twice in quick succession. 

Marquee select  Means to depress the mouse button and continue to hold it down while moving the 

mouse. As you drag the mouse, a rectangle (known as a marquee) follows the cursor. 

Release the mouse button and the area inside the marquee is selected. 

Conventions 

Various styles of text and layout have been used in this manual to help differentiate between different kinds 

of information. The styles and layout are explained below: 

Bold All bold typeface makes reference to either a menu or a menu item command such as 

File or Save, or a tab such as Description or Grid. 

Mono-space Indicates something you should enter with the keyboard. For example, type 

“c:\*.txt”. 

KEY + KEY Indicates a key combination. The plus sign indicates that you should press and hold the 

first key while pressing the second key, then release both keys. For example, “ALT + 

F” indicates that you should press the “ALT” key and hold it while you press the “F” 

key, then release both keys. 

SMALL CAPS Indicates the name of an object such as a dialog box or a dialog box component. For 

example, the OPEN dialog box or the CANCEL or MODIFY buttons. 

Installing, Purchasing, and Licensing spMats 

For instructions on how to install, purchase, and license StructurePoint software please refer to support pages 

on the StructurePoint website at www.StructurePoint.org. 

 

http://www.structurepoint.org/




 

Chapter 2 – Method of Solution 

Method of Solution 

spMats uses the Finite Element Method for the structural modeling and analysis of reinforced concrete slab 

systems or mat foundations subject to static loading conditions.  

The slab is idealized as a mesh of rectangular elements interconnected at the corner nodes. The same mesh 

applies to the underlying soil with the soil stiffness concentrated at the nodes. Slabs of irregular geometry 

should be idealized to conform to geometry with rectangular boundaries. Even though slab and soil properties 

can vary between elements, they are assumed uniform within each element.  

Three degrees of freedom are considered at each node, i.e., a vertical translation and two rotations about the 

two orthogonal axes. An external load can exist in the direction of each of the above degrees of freedom, i.e., 

a vertical force and two moments about the Cartesian axes. 

Global Coordinate system 

The mid-surface of the slab lies in the XY plane of the right-handed XYZ orthogonal coordinate system 

shown in Figure 2-1. The slab thickness is measured in the direction of the Z-axis. Looking at the display 

monitor, the origin of the coordinate system is located in the bottom left corner of the screen. The positive X-

axis points to the right, the positive Y-axis points upward towards the top of the monitor, and the positive Z-

axis points out of the screen. Thus, the XY plane is defined as being the plane of the display monitor. 

Y
Z

Z

X X

Y
Display
Monitor

 

Figure 2-1 Global Coordinate System 

Mesh Generation  

The nodal coordinates of the finite element mesh are internally computed by the program based on the 

reference rectangular grid system shown in Figure 2-2. 

A group of grid lines, orthogonal to the X- and Y-axes, are defined by inputting their X and Y coordinates 

respectively. The intersection of two orthogonal grid lines forms a grid intersection. The space formed by the 

intersection of two consecutive X-grid lines and two consecutive Y-grid lines is a grid space. The assignment 

of plate finite elements to the slab model is done by applying element thicknesses to the grid spaces. 
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Figure 2-2 Reference Grid System 

Preparing Input 

The first step in preparing the input is to draw a scaled plan view of the slab. The plan should include the 

boundaries slab, variations in the slab thickness and material properties, openings within the slab, and any 

variations in the soil sub-grade modulus. All superimposed loads applied on the slab should also be shown.  

The next step is to superimpose a rectangular grid system over the plan of the slab. The following factors 

control the grid layout:  

1. Grid lines must exist along slab boundaries and openings. Slab boundaries not parallel to the X- or 

Y-axis may be defined by steps that approximate the sloped boundary.  

2. Grid lines must exist along the boundaries of slab thickness changes, slab material property 

changes, and soil property changes. 

3. Grid lines must exist along boundaries of surface loads. 

4. Grid lines must intersect at the locations of point loads and point supports.  

The above guidelines basically form the major grid lines, which produce the minimum number of finite 

elements for the particular mat geometry. The mesh can be refined by supplementing the model with minor 

grid lines between the major grid lines. Minor grid lines need to be added to achieve a uniform, well-graded 

mesh that produces results which will effectively capture the variations of the displacements and element 

forces. The location of the minor grid lines also depends on the level of accuracy that is desired from the 

analysis.  

While the use of finer meshes will generally produce more accurate results, it will also require more solution 

time, computer memory, and disk space. Elements with aspect ratios (length/width) near unity are generally 

expected to produce accurate results for regions having gradual changes of curvature. For slab regions where 

heavy concentrated forces are applied and where drastic changes in geometry exist, the use of finer element 

meshes may be required. Thus, in order to obtain a practical as well as accurate analytical solution, 

engineering judgment must be used.  

The member nodal incidences are internally computed by the program. All nodes and members are numbered 

from left to right (in the positive X-direction) and from bottom to top (in the positive Y-direction), as shown 

in Figure 2-3. When the reference grid system and/or assembling of elements is modified, the program 

internally renumbers all nodes and elements. In order to save solution time, memory, and disk space, it is 

recommended to position the side of the slab with fewer nodes (i.e., fewer degrees of freedom) parallel to the 

X-direction.  



 

Method of Solution  2-3 

Y Y

X X

1

6 7 8 9 10 11 12

11 12 13 14

15 16 17 18

65 7 8 9 10

2019 21 22 23 24

2625 27 28 29 30

13 14 15 16 17 18 19

20 21 22 23 24 25

26 27 28 29 30 31 32

33 34 35 36 37 38 39

40 41 42 43 44 45 46

2 3 4

1 2 3 4

5  

Figure 2-3 Node and Element Numbering 

Plate Element 

The rectangular plate finite element1 used in the program has four nodes at the corners and three degrees of 

freedom (Dz, Rx and Ry) per node, as shown in Figure 2-4. This element considers the thin plate theory, which 

makes use of the following Kirchhoff hypotheses:  

1. Plane sections initially normal to the mid-surface remain plane and normal to that surface after 

bending.  

2. The stress component normal to the mid-plane is small compared to other stress components and 

is neglected.  

3. The deflection of the mid-surface is small compared to the thickness of the plate.  

4. The mid-plane remains unstrained subsequent to bending.  

The element material is homogeneous, isotropic, and obeys Hooke’s law. Constant thickness and constant 

material properties are assumed within an element. Cracking effects or changes in the slab elevation are not 

taken into account in the model. 

Note that when deflections are not small, the bending of plates is accompanied by strain in the mid-plane. 

Further, for thick slabs, shear deformations (which are not considered by the program) may be significant, 

and a finite plate element based on the more general Mindlin’s Theory may be required.  
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Figure 2-4 Plate Finite Element 
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Nodal Restraints and Slaved Degrees of Freedom  

All nodal degrees of freedom (DOF) are assumed to be initially released (i.e., free to move). Mathematically 

speaking, each DOF implies an equilibrium equation; however, nodal DOFs may be fully restrained against 

displacement and/or rotation. Partial restraint in the Z direction is possible with the use of translational 

springs. Furthermore, degrees of freedom may be slaved to share the same displacement or rotation at specific 

nodes. Slaving enforces uniform deformation modes at selected nodes that can help in modeling stiff 

structural elements such as walls and pedestals. Applying a full restraint and slaving of a node (or nodes in a 

group) for the same degree of freedom is not allowed. Either only restraining all nodes (zero displacement) in 

a group or only slaving of all nodes in a group (same non-zero displacement) should be applied. 

Slaving of degrees of freedom produces a stiffer slab system and reduces the number of equations to be 

solved. It should be noted that slaved degrees of freedom (SLDOF) are assigned by grouping of nodes. A 

group of nodes can be designated to share the same Dz, Rx or Ry. If a group of nodes should share all three 

degrees of freedom, three different SLDOF groups (one for each DOF) must be defined. It should also be 

noted that a node can belong to more than one SLDOF group as long as these groups are slaved for different 

degrees of freedom. The external load corresponding to a SLDOF group corresponds to the sum of loads 

applied to all slaved nodes in the groups. 

Winkler’s Foundation 

The soil supporting the slab is modeled as a group of linear uncoupled springs (Winkler type) concentrated at 

the nodes. The soil element is tensionless, weightless, and has one degree of freedom, which is the 

displacement in the Z direction (Dz). The contribution of each element node to the soil spring stiffness is 

equal to the nodal tributary area (1/4 the element area) multiplied by the soil subgrade modulus, Ks, under the 

element. The common nodes of adjacent elements undergo the same displacement. Therefore, if the adjacent 

elements have dissimilar soil properties, the soil pressures at the common nodes of these elements will differ 

in proportion to their respective soil subgrade modulus values.  

The contact pressure, Pz, under each element node is proportional to the nodal deflection, Dz.  

 z s zP K D . Eq. 2-1 

Usually, several factors are considered in the determination of the 

subgrade modulus: the size and shape of the footing, soil type below 

the footing and deeper, type and duration of loading, footing 

stiffness, and superstructure stiffness. The program does not perform 

any correction on the input subgrade modulus to account for these or 

any other factors. 

Additional nodal springs may be applied in parallel to the Winkler’s 

springs, as shown in Figure 2-5. Accordingly, their linear stiffness, 

Kns, is added to the equivalent spring constant.  

The nodal spring reaction at a particular node is proportional to the 

nodal deflection, Dz.  

 z ns zF K D . Eq. 2-2 

Piles 

Piles are modeled as springs connected to the nodes of the finite element model. Unlike for springs, however, 

punching shear check is performed around piles. 

The spring constant, Kp, for a pile is calculated from the formula: 

 u
p

Q
K

S
 , Eq. 2-3  
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where Qu denotes the load applied to the pile and S is the corresponding settlement of the pile. Assuming soil 

allowable pressure, Pall, acting on the pile base, Qu equals all pP A , where Ap is pile cross sectional area. 

Neglecting long-term effects, the settlement of pile is estimated from the empirical formula for a single pile in 

cohesionless soil2:  

 u

p p

Q LD
S

100 A E
  , Eq. 2-4  

where D is pile diameter, L is pile length, and Ep is modulus of elasticity of pile material. The above formula 

is units independent as long as all of its terms have consistent units. For noncircular piles, an effective 

diameter is calculated from the formula: 

 
p4A

D 


. Eq. 2-5  

Types of Loads  

External loads are applied as concentrated nodal loads and/or element surface loads according to the sign 

convention shown in Figure 2-6. 

A concentrated nodal load consists of a vertical load, Pz, and two concentrated moments about the X and Y 

axes, Mx and My. It should be noted that a positive vertical load is applied upward (in the positive Z-

direction). 

 

Figure 2-6 Applied Loads 

The uniform element surface load, wz, applied over an element is internally discretized by the program into 

equivalent nodal loads as shown in Eq. 2-6: 

                                                           

2 Reference [8] 
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 Eq. 2-6  

where a and b are the element dimensions.  

The self-weight of the slab is computed internally based on the concrete unit weight and the thickness of each 

element. The self-weight is treated like a surface load and may optionally be considered in the analysis under 

the dead load case. 

Load Cases and Combinations 

Each load is applied to the slab under one of the 26 (A through Z) load cases. The slab is analyzed and 

designed under load combinations. A load combination is the algebraic sum of each of the load cases 

multiplied by a load factor.  

Load combinations are categorized into service-level and ultimate-level. For service-level load combinations, 

force vector, displacement vector, reactions, and soil displacements and pressures are output. For ultimate-

level load combinations, force vector, displacement vector, reactions, element nodal moments, and punching 

shear results are output. The output is available only when solution criteria are met for all load combinations. 

Basic load cases and the corresponding load factors for service and ultimate load combinations are provided 

as defaults in the input file templates (activated in OPTIONS / STARTUP DEFAULTS window) to facilitate user’s 

input. The default load cases and load combination factors should be modified as necessary at the discretion 

of the user. 

The following default load cases are suggested: A – Dead (D), B – Live (L), C – Snow (S), D – Wind (W), 

E – Earthquake (E), and F – Soil (H). Service-level load values are considered for all load cases except case 

E, in all design codes, and case W, in ACI 318-14 and ACI 318-11 only, which are taken at ultimate-level. 

The suggested default load combination factors for service and ultimate load levels are shown below. Under 

service load level, allowable stress design load factors are considered for calculating foundation pressure3. 

The user should introduce additional service-level load combinations as required, e.g., for checking 

displacement limits4. 

For ACI 318-14/115 

 Service load combinations: 

S1 = 1.0D + 1.0H 

S2 = 1.0D + 0.6H 

                                                           

3 IBC 2009, 1806.1; IBC 2006, 1804.1; IBC 2003, 1804.1; IBC 2000, 1804.1; NBCC, 4.2.4.4 
4 Two input files may be needed, one with allowable stress design load factors for foundation pressure check and one with load factors 

for checking displacements to avoid enveloping results for different sets of load factors under service level combinations. 
5 Soil (H) load is taken as permanent. 
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S3 = 1.0D + 1.0L + 1.0H 

S4 = 1.0D + 1.0L + 0.6H 

S5 = 1.0D + 1.0S + 1.0H 

S6 = 1.0D + 1.0S + 0.6H 

S7 = 1.0D + 0.75L + 0.75S + 1.0H 

S8 = 1.0D + 0.75L + 0.75S + 0.6H 

S9 = 1.0D + 0.6W + 1.0H 

S10 = 1.0D + 0.6W + 0.6H 

S11 = 1.0D - 0.6W + 1.0H 

S12 = 1.0D - 0.6W + 0.6H 

S13 = 1.0D + 0.7E + 1.0H 

S14 = 1.0D + 0.7E + 0.6H 

S15 = 1.0D - 0.7E + 1.0H 

S16 = 1.0D - 0.7E + 0.6H 

S17 = 1.0D + 0.75L + 0.75S + 0.45W + 1.0H 

S18 = 1.0D + 0.75L + 0.75S + 0.45W + 0.6H 

S19 = 1.0D + 0.75L + 0.75S - 0.45W + 1.0H 

S20 = 1.0D + 0.75L + 0.75S - 0.45W + 0.6H 

S21 = 1.0D + 0.75L + 0.75S + 0.525E + 1.0H 

S22 = 1.0D + 0.75L + 0.75S + 0.525E + 0.6H 

S23 = 1.0D + 0.75L + 0.75S - 0.525E + 1.0H 

S24 = 1.0D + 0.75L + 0.75S - 0.525E + 0.6H 

S25 = 0.6D + 0.6W + 1.0H 

S26 = 0.6D + 0.6W + 0.6H 

S27 = 0.6D - 0.6W + 1.0H 

S28 = 0.6D - 0.6W + 0.6H 

S29 = 0.6D + 0.7E + 1.0H 

S30 = 0.6D + 0.7E + 0.6H 

S31 = 0.6D - 0.7E + 1.0H 

S32 = 0.6D - 0.7E + 0.6H 

 Ultimate load combinations6: 

U1 = 1.4D + 1.6H 

U2 = 1.4D + 0.9H 

U3 = 1.2D + 1.6L + 0.5S + 1.6H 

U4 = 1.2D + 1.6L + 0.5S + 0.9H 

U5 = 1.2D + 1.0L + 1.6S + 1.6H 

U6 = 1.2D + 1.0L + 1.6S + 0.9H 

U7 = 1.2D + 1.6S + 0.5W + 1.6H 

U8 = 1.2D + 1.6S + 0.5W + 0.9H 

U9 = 1.2D + 1.6S - 0.5W + 1.6H 

U10 = 1.2D + 1.6S - 0.5W + 0.9H 

U11 = 1.2D + 1.0L + 0.5S + 1.0W + 1.6H 

                                                           

6 ACI 318-14, 5.3; ACI 318-11, 9.2 
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U12 = 1.2D + 1.0L + 0.5S + 1.0W + 0.9H 

U13 = 1.2D + 1.0L + 0.5S - 1.0W + 1.6H 

U14 = 1.2D + 1.0L + 0.5S - 1.0W + 0.9H 

U15 = 0.9D + 1.0W + 1.6H 

U16 = 0.9D + 1.0W + 0.9H 

U17 = 0.9D - 1.0W + 1.6H 

U18 = 0.9D - 1.0W + 0.9H 

U19 = 1.2D + 1.0L + 0.2S + 1.0E + 1.6H 

U20 = 1.2D + 1.0L + 0.2S + 1.0E + 0.9H 

U21 = 1.2D + 1.0L + 0.2S - 1.0E + 1.6H 

U22 = 1.2D + 1.0L + 0.2S - 1.0E + 0.9H 

U23 = 0.9D + 1.0E + 1.6H 

U24 = 0.9D + 1.0E + 0.9H 

U25 = 0.9D - 1.0E + 1.6H 

U26 = 0.9D - 1.0E + 0.9H 

For ACI 318-08/05/02 

 Service load combinations7: 

S1 = 1.0D 

S2 = 1.0D + 1.0L + 1.0H 

S3 = 1.0D + 1.0S + 1.0H 

S4 = 1.0D + 0.75L + 0.75S + 1.0H 

S5 = 1.0D + 1.0W + 1.0H 

S6 = 1.0D - 1.0W + 1.0H 

S7 = 1.0D + 0.7E + 1.0H 

S8 = 1.0D - 0.7E + 1.0H 

S9 = 1.0D + 0.75L + 0.75S + 0.75W + 1.0H 

S10 = 1.0D + 0.75L + 0.75S - 0.75W + 1.0H 

S11 = 1.0D + 0.75L + 0.75S + 0.525E + 1.0H 

S12 = 1.0D + 0.75L + 0.75S - 0.525E + 1.0H 

S13 = 0.6D + 1.0W + 1.0H 

S14 = 0.6D - 1.0W + 1.0H 

S15 = 0.6D + 0.7E + 1.0H 

S16 = 0.6D - 0.7E + 1.0H 

 Ultimate load combinations8: 

U1 = 1.4D 

U2 = 1.2D + 1.6L + 0.5S + 1.6H 

U3 = 1.2D + 1.0L + 1.6S 

U4 = 1.2D + 1.6S + 0.8W 

U5 = 1.2D + 1.6S - 0.8W 

U6 = 1.2D + 1.0L + 0.5S + 1.6W 

                                                           

7 IBC 2006, 1605.3.1; IBC 2003, 1605.3.1; IBC 2000, 1605.3.1 
8 ACI 318-08, 9.2; ACI 318-05, 9.2; ACI 318-02, 9.2 
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U7 = 1.2D + 1.0L + 0.5S - 1.6W 

U8 = 0.9D + 1.6W 

U9 = 0.9D - 1.6W 

U10 = 0.9D + 1.6W + 1.6H 

U11 = 0.9D - 1.6W + 1.6H 

U12 = 1.2D + 1.0L + 0.2S + 1.0E 

U13 = 1.2D + 1.0L + 0.2S - 1.0E 

U14 = 0.9D + 1.0E 

U15 = 0.9D - 1.0E 

U16 = 0.9D + 1.0E + 1.6H 

U17 = 0.9D - 1.0E + 1.6H 

For CSA A23.3-14/04 

spMats reports soil pressure for service combinations only. The suggested service load combinations are 

based on CSA A23.3-94. To comply with clause N15.2.2 in Explanatory Notes on CSA A23.3-04 (Ref. [22]), 

the user should use appropriate load factors in conjunction with service-level combinations to determine soil 

pressure for factored loads9. 

 Service load combinations: 

S1 = 1.0D 

S2 = 1.0D + 1.0L + 1.0S + 1.0H 

S3 = 1.0D + 1.0W 

S4 = 1.0D - 1.0W 

S5 = 1.0D + 0.667E 

S6 = 1.0D - 0.667E 

S7 = 0.75D + 0.75L + 0.75S + 0.75W + 0.75H 

S8 = 0.75D + 0.75L + 0.75S - 0.75W + 0.75H 

S9 = 0.75D + 0.75L + 0.75S + 0.5E + 0.75H 

S10 = 0.75D + 0.75L + 0.75S - 0.5E + 0.75H 

 Ultimate load combinations for CSA A23.3-1410: 

U1 = 1.4D 

U2 = 1.25D + 1.5L 

U3 = 1.25D + 1.5L + 1.5H 

U4 = 1.25D + 1.5L + 1.0S 

U5 = 1.25D + 1.5L + 1.0S + 1.5H 

U6 = 1.25D + 1.5L + 0.4W 

U7 = 1.25D + 1.5L + 0.4W + 1.5H 

U8 = 1.25D + 1.5L - 0.4W 

U9 = 1.25D + 1.5L - 0.4W + 1.5H 

U10 = 0.9D + 1.5L 

U11 = 0.9D + 1.5L + 1.5H 

U12 = 0.9D + 1.5L + 1.0S 

                                                           

9 Two input files may be needed, one with load factors for foundation pressure check, and one with load factors for checking 

displacements to avoid enveloping results for different sets of load factors under service-level combinations. 
10 CSA A23.3-14, Annex C 
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U13 = 0.9D + 1.5L + 1.0S + 1.5H 

U14 = 0.9D + 1.5L + 0.4W 

U15 = 0.9D + 1.5L + 0.4W + 1.5H 

U16 = 0.9D + 1.5L - 0.4W 

U17 = 0.9D + 1.5L - 0.4W + 1.5H 

U18 = 1.25D + 1.5S 

U19 = 1.25D + 1.5S + 1.5H 

U20 = 1.25D + 1.0L + 1.5S 

U21 = 1.25D + 1.0L + 1.5S + 1.5H 

U22 = 1.25D + 1.5S + 0.4W 

U23 = 1.25D + 1.5S + 0.4W + 1.5H 

U24 = 1.25D + 1.5S - 0.4W 

U25 = 1.25D + 1.5S - 0.4W + 1.5H 

U26 = 0.9D + 1.5S 

U27 = 0.9D + 1.5S + 1.5H 

U28 = 0.9D + 1.0L + 1.5S 

U29 = 0.9D + 1.0L + 1.5S + 1.5H 

U30 = 0.9D + 1.5S + 0.4W 

U31 = 0.9D + 1.5S + 0.4W + 1.5H 

U32 = 0.9D + 1.5S - 0.4W 

U33 = 0.9D + 1.5S - 0.4W + 1.5H 

U34 = 1.25D + 1.4W 

U35 = 1.25D + 1.4W + 1.5H 

U36 = 1.25D + 0.5L + 1.4W 

U37 = 1.25D + 0.5L + 1.4W + 1.5H 

U38 = 1.25D + 0.5S + 1.4W 

U39 = 1.25D + 0.5S + 1.4W + 1.5H 

U40 = 1.25D - 1.4W 

U41 = 1.25D - 1.4W + 1.5H 

U42 = 1.25D + 0.5L - 1.4W 

U43 = 1.25D + 0.5L - 1.4W + 1.5H 

U44 = 1.25D + 0.5S - 1.4W 

U45 = 1.25D + 0.5S - 1.4W + 1.5H 

U46 = 0.9D + 1.4W 

U47 = 0.9D + 1.4W + 1.5H 

U48 = 0.9D + 0.5L + 1.4W 

U49 = 0.9D + 0.5L + 1.4W + 1.5H 

U50 = 0.9D + 0.5S + 1.4W 

U51 = 0.9D + 0.5S + 1.4W + 1.5H 

U52 = 0.9D - 1.4W 

U53 = 0.9D - 1.4W + 1.5H 

U54 = 0.9D + 0.5L - 1.4W 

U55 = 0.9D + 0.5L - 1.4W + 1.5H 

U56 = 0.9D + 0.5S - 1.4W 
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U57 = 0.9D + 0.5S - 1.4W + 1.5H 

U58 = 1.0D + 1.0E 

U59 = 1.0D + 1.0L + 0.25S + 1.0E 

U60 = 1.0D - 1.0E 

U61 = 1.0D + 1.0L + 0.25S - 1.0E 

 Ultimate load combinations for CSA A23.3-0411: 

U1 = 1.4D 

U2 = 1.25D + 1.5L 

U3 = 1.25D + 1.5L + 1.5H 

U4 = 1.25D + 1.5L + 0.5S 

U5 = 1.25D + 1.5L + 0.5S + 1.5H 

U6 = 1.25D + 1.5L + 0.4W 

U7 = 1.25D + 1.5L + 0.4W + 1.5H 

U8 = 1.25D + 1.5L - 0.4W 

U9 = 1.25D + 1.5L - 0.4W + 1.5H 

U10 = 0.9D + 1.5L 

U11 = 0.9D + 1.5L + 1.5H 

U12 = 0.9D + 1.5L + 0.5S 

U13 = 0.9D + 1.5L + 0.5S + 1.5H 

U14 = 0.9D + 1.5L + 0.4W 

U15 = 0.9D + 1.5L + 0.4W + 1.5H 

U16 = 0.9D + 1.5L - 0.4W 

U17 = 0.9D + 1.5L - 0.4W + 1.5H 

U18 = 1.25D + 1.5S 

U19 = 1.25D + 1.5S + 1.5H 

U20 = 1.25D + 0.5L + 1.5S 

U21 = 1.25D + 0.5L + 1.5S + 1.5H 

U22 = 1.25D + 1.5S + 0.4W 

U23 = 1.25D + 1.5S + 0.4W + 1.5H 

U24 = 1.25D + 1.5S - 0.4W 

U25 = 1.25D + 1.5S - 0.4W + 1.5H 

U26 = 0.9D + 1.5S 

U27 = 0.9D + 1.5S + 1.5H 

U28 = 0.9D + 0.5L + 1.5S 

U29 = 0.9D + 0.5L + 1.5S + 1.5H 

U30 = 0.9D + 1.5S + 0.4W 

U31 = 0.9D + 1.5S + 0.4W + 1.5H 

U32 = 0.9D + 1.5S - 0.4W 

U33 = 0.9D + 1.5S - 0.4W + 1.5H 

U34 = 1.25D + 1.4W 

U35 = 1.25D + 1.4W + 1.5H 

U36 = 1.25D + 0.5L + 1.4W 

                                                           

11 CSA A23.3-04, Annex C 
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U37 = 1.25D + 0.5L + 1.4W + 1.5H 

U38 = 1.25D + 0.5S + 1.4W 

U39 = 1.25D + 0.5S + 1.4W + 1.5H 

U40 = 1.25D - 1.4W 

U41 = 1.25D - 1.4W + 1.5H 

U42 = 1.25D + 0.5L - 1.4W 

U43 = 1.25D + 0.5L - 1.4W + 1.5H 

U44 = 1.25D + 0.5S - 1.4W 

U45 = 1.25D + 0.5S - 1.4W + 1.5H 

U46 = 0.9D + 1.4W 

U47 = 0.9D + 1.4W + 1.5H 

U48 = 0.9D + 0.5L + 1.4W 

U49 = 0.9D + 0.5L + 1.4W + 1.5H 

U50 = 0.9D + 0.5S + 1.4W 

U51 = 0.9D + 0.5S + 1.4W + 1.5H 

U52 = 0.9D - 1.4W 

U53 = 0.9D - 1.4W + 1.5H 

U54 = 0.9D + 0.5L - 1.4W 

U55 = 0.9D + 0.5L - 1.4W + 1.5H 

U56 = 0.9D + 0.5S - 1.4W 

U57 = 0.9D + 0.5S - 1.4W + 1.5H 

U58 = 1.0D + 1.0E 

U59 = 1.0D + 1.0L + 0.25S + 1.0E 

U60 = 1.0D - 1.0E 

U61 = 1.0D + 1.0L + 0.25S - 1.0E 

For CSA A23.3-94 

 Service load combinations12: 

S1 = 1.0D 

S2 = 1.0D + 1.0L + 1.0S + 1.0H 

S3 = 1.0D + 1.0W 

S4 = 1.0D - 1.0W 

S5 = 1.0D + 0.667E 

S6 = 1.0D - 0.667E 

S7 = 0.75D + 0.75L + 0.75S + 0.75W + 0.75H 

S8 = 0.75D + 0.75L + 0.75S - 0.75W + 0.75H 

S9 = 0.75D + 0.75L + 0.75S + 0.5E + 0.75H 

S10 = 0.75D + 0.75L + 0.75S - 0.5E + 0.75H 

 Ultimate load combinations13: 

U1 = 1.25D 

U2 = 1.25D + 1.5L 

                                                           

12 NBCC 95, 4.1.4.1, 4.1.4.2 
13 CSA A23.3-94, 8.3.2 
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U3 = 1.25D + 1.5L + 1.5S 

U4 = 1.25D + 1.5L + 1.5S + 1.5H 

U5 = 1.25D + 1.5W 

U6 = 1.25D - 1.5W 

U7 = 1.25D + 1.05L + 1.05W 

U8 = 1.25D + 1.05L + 1.05S + 1.05W 

U9 = 1.25D + 1.05L + 1.05S + 1.05W + 1.05H 

U10 = 1.25D + 1.05L - 1.05W 

U11 = 1.25D + 1.05L + 1.05S - 1.05W 

U12 = 1.25D + 1.05L + 1.05S - 1.05W + 1.05H 

U13 = 0.85D + 1.5L 

U14 = 0.85D + 1.5L + 1.5S 

U15 = 0.85D + 1.5L + 1.5S + 1.5H 

U16 = 0.85D + 1.5W 

U17 = 0.85D - 1.5W 

U18 = 0.85D + 1.05L + 1.05W 

U19 = 0.85D + 1.05L + 1.05S + 1.05W 

U20 = 0.85D + 1.05L + 1.05S + 1.05W + 1.05H 

U21 = 0.85D + 1.05L - 1.05W 

U22 = 0.85D + 1.05L + 1.05S - 1.05W 

U23 = 0.85D + 1.05L + 1.05S - 1.05W + 1.05H 

U24 = 1.0D + 1.0E 

U25 = 1.0D - 1.0E 

U26 = 1.0D + 1.0L + 1.0E 

U27 = 1.0D + 1.0L + 1.0S + 1.0E 

U28 = 1.0D + 1.0L + 1.0S + 1.0E + 1.0H 

U29 = 1.0D + 1.0L - 1.0E 

U30 = 1.0D + 1.0L + 1.0S - 1.0E 

U31 = 1.0D + 1.0L + 1.0S - 1.0E + 1.0H 

Nonlinear Solution 

The supporting soil, nodal springs, and piles are assumed to be tensionless. When nodal uplift occurs, an 

iterative procedure is used to eliminate the corresponding soil, pile, and nodal spring stiffness contributions to 

the global stiffness of the entire slab/soil structural system and to re-solve the equilibrium equations.  

The controlling parameters for the solution of the nonlinear problem are: maximum number of iterations, 

maximum service displacement limit, minimum ratio of soil contact area (with respect to initial soil supported 

area), and minimum ration of active spring and piles (with respect to the total number of spring and piles). 

This iterative procedure is repeated for each load combination until all tensile soil, pile, and nodal springs are 

deactivated, converge test is passed (i.e., Euclidean norm of relative displacement increments falls below 

0.001), and the equilibrium is reached. For any load combination, if convergence test is not passed or 

equilibrium cannot be reached within the user-specified limit values of the controlling parameters, the 

program terminates the solution. 

The solution process is summarized in the following steps:  

1. Compute the plate element stiffness matrices. 

2. Compute the spring element stiffness matrices for soil, piles, and nodal springs.  
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3. Assemble the global stiffness matrix.  

4. Combine the applied loads based on the defined load combinations and form the load vector. 

5. Apply restraints and nodal slaving constraints to the global stiffness matrix and load vector. 

6. Compute the displacement vector, U, by solving the equilibrium equation:  

 K U F , Eq. 2-7 

where K is the global stiffness matrix and F is the force vector.  

7. If uplift (upward displacement) is detected at any node with a spring, the spring contribution at that node 

is eliminated and the procedure (from step 2 above) is repeated until convergence criteria are met and 

equilibrium is reached. This is checked only if springs are present.  

8. Compute reactions for springs, piles, restraints, and slaved degrees of freedom. 

9. Compute soil pressures (service combinations only). 

10. Compute element internal forces, i.e., bending moments, twisting moments, principal moments, and 

design bending (Wood-Armer) moments (ultimate combinations only). 

11. Repeat steps 4 through 10 for each combination. 

12. For all service-level combinations, envelopes are computed for displacements, pressures, and spring 

reactions.  

13. For all ultimate-level combinations, the element design bending moment envelopes are computed along 

with the corresponding required area of reinforcing steel. 

14. Punching shear stresses are checked around columns and piles for each ultimate load combination. 

Element Internal Moments 

The bending moments, Mxx and Myy, and the twisting moment, Mxy, are computed at the corner nodes of each 

element. Figure 2-7 shows the element moment sign convention used by the program. Note that unlike in 

beams and columns, the traditional plate and shell theory convention is that Mxx denotes the moment along 

(not about) the X-axis and Myy denotes the moment along the Y-axis. Both moments are positive when they 

produce tension at the top. 

The principal moments, Mr1 and Mr2, and the principal angle (see Figure 2-8), are computed from the general 

moment transformation equations:  

  2 2
r1 xx yy xyM M cos M sin M sin 2    , Eq. 2-8  

  2 2
r2 xx yy xyM M sin M cos M sin 2    . Eq. 2-9 
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Figure 2-7 Element Nodal Moments 
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Note that since Mr1 and Mr2 are principal moments, the twisting moment associated with the r1-r2 axes (Mr12) 

is zero: 

    yy xx
r12 xy

M M
M sin 2 M cos 2 0

2


     , Eq. 2-10  

and the angle θ is: 

 
xy1

xx yy

2M1
tan

2 M M


 

   
  

. Eq. 2-11  
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Figure 2-7 Element Principal Moment 

Element Design Moments 

In practice, flexural reinforcement is generally provided in the orthogonal directions of the slab system (X-Y) 

and not in the principal directions (r1-r2). Therefore, the Principal of Minimum Resistance14 is used by the 

program to obtain values for the design moments, which include the effects of the twisting moment.  

The equivalent design bending moments, Mux and Muy, for the design of reinforcing steel respectively in the X 

and Y direction are computed as follows:  

 For top reinforcement where positive moments produce tension:  

 ux xx xyM M M  , Eq. 2-12  

 uy yy xyM M M  . Eq. 2-13  

However, if either Mux or Muy is found to be negative, the negative value of the moment is changed to zero 

and the other moment is given as follows:  

 if uxM 0 , then uxM 0  and 

2
xy

uy yy
xx

M
M M

M
  , Eq. 2-14  

 if uyM 0 , then uyM 0  and 

2
xy

ux xx
yy

M
M M

M
  . Eq. 2-15  

 For bottom reinforcement where negative moments produce tension:  

 ux xx xyM M M  , Eq. 2-16  

                                                           

14 References [1], [2], [3], and [4]. 
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 uy yy xyM M M  . Eq. 2-17  

However, if either Mux or Muy is found to be positive, the positive value of the moment is changed to zero and 

the other moment is given as follows:  

 if uxM 0 , then uxM 0  and 

2
xy

uy yy
xx

M
M M

M
  , Eq. 2-18  

 if uyM 0 , then uyM 0  and 

2
xy

ux xx
yy

M
M M

M
  . Eq. 2-19  

Required Reinforcement 

The required area of reinforcing steel is computed based on a rectangular section with no compression 

reinforcement and one layer of tension reinforcement. The assumptions and limits used conform to the design 

specifications based on the accepted Strength Design Method and Unified Design Provisions. 

The maximum usable strain at the extreme concrete compression fiber15 is 0.003 for ACI standards and 

0.0035 for CSA standards. The rectangular concrete stress block is assumed with the block depth equal to:  

 1a c  , Eq. 2-20 

where c is the distance from the extreme compression fiber to the neutral axis and factor 1  equals  

 
'

1 c0.65 1.05 0.05f 0.85      Eq. 2-21 

for ACI standards16 and 

 
'

1 c0.67 1.05 0.025f     Eq. 2-22 

for CSA standards17. To compute the stress in the steel layer, the elastic-perfectly plastic stress-strain 

distribution is used. The required area of reinforcing steel is calculated as: 

 sA bd  , Eq. 2-23 

which reinforcement ratio,  , equal to 

  g 1 1 m    , Eq. 2-24 

where factors m and g are calculated for ACI standards as 

 u
' 2
c

2M
m

0.85 f bd



, Eq. 2-25 

 
'
c

y

f
g 0.85

f
 , Eq. 2-26 

with strength reduction factor 0.9   for tension controlled sections18. 

For CSA standards, factors m and g are equal to 

                                                           

15 ACI 318-14, 10.2.2.1; ACI 318-11, 10.2.3; ACI 318-08, 10.2.3; ACI 318-05, 10.2.3; ACI 318-02, 10.2.3; CSA A23.3-04, 10.1.3; CSA 
A23.3-94, 10.1.3 
16 ACI 318-14, 22.2.2.4.3; ACI 318-11, 10.2.7.3; ACI 318-08, 10.2.7.3; ACI 318-05, 10.2.7.3; ACI 318-02, 10.2.7.3 
17 CSA A23.3-14, 10.1.7(c); CSA A23.3-04, 10.1.7(c); CSA A23.3-94, 10.1.7(c) 
18 ACI 318-14, 21.2; ACI 318-11, 9.3.2; ACI 318-08, 9.3.2; ACI 318-05, 9.3.2; ACI 318-02, 9.3.2 
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 f
' 2

1 c c

2M
m

f bd

 

, Eq. 2-27 

 
'

c c
1

s y

f
g

f


 


, Eq. 2-28 

where 1 is defined as 

 '
1 c0.67 0.85 0.0015f     Eq. 2-29 

and steel resistance factor19 s 0.85  and concrete resistance factor20, c , that takes value of c 0.60  for 

CSA A23.3-94, c 0.65  for CSA A23.3-04 and CSA A23.3-14, and c 0.70  in case of precast concrete 

for CSA A23.3-04 and CSA A23.3-14 standards. 

1 is the ratio of the average stress in the rectangular compression block to the specified concrete strength. It 

equals 0.85 for ACI Code21 and 
'0015.085.0 cf  but not less than 0.67 for the CSA Standard22. 

Maximum Reinforcement 

For the ACI Code, the maximum reinforcement ratio is derived from the condition23 that the net tensile strain 

at nominal strength is not less than 0.004. 

For the CSA Standard, the area of tension reinforcement is such that the neutral axis-to-depth ratio is24:  

 
y

c 700

d 700 f



. Eq. 2-30  

When the required area of steel exceeds the maximum allowed by the code, the program provides a warning 

message during solution stating that steel design of some elements failed. 

Minimum Reinforcement 

The minimum amount of reinforcement in each layer is computed as the minimum reinforcement ratio 

defined by the user multiplied by the gross area. Since minimum reinforcement area is calculated by the 

program separately for each of the two layers, the user should provide half of the minimum reinforcement 

ratio stipulated by design standards for total reinforcement in order to meet the standards requirements. 

For ACI, the minimum total reinforcement amount required in foundations is equal to25 0.002Ag for steel 

Grade 40 or 50, 0.0018Ag for steel Grade 60, and (0.0018·60,000/fy)Ag for reinforcement with yield stress 

exceeding 60,000 psi. 

For CSA standards26, the minimum reinforcement requirement is equal to 0.002Ag. 

Punching Shear Check 

The punching shear in spMats is checked for columns and piles. For ACI standards, the following condition is 

used: 

                                                           

19 CSA A23.3-14, 8.4.3; CSA A23.3-04, 8.4.3; CSA A23.3-94, 8.4.3 
20 CSA A23.3-14, 8.4.2, 16.1.3; CSA A23.3-04, 8.4.2, 16.1.3; CSA A23.3-94, 8.4.2 
21 ACI 318-14, 22.2.2.3; ACI 318-11, 10.2.6; ACI 318-08, 10.2.6, 10.2.7; ACI 318-05, 10.2.6, 10.2.7; ACI 318-02, 10.2.6, 10.2.6 
22 CSA A23.3-14, 10.1.1; CSA A23.3-04, 10.1.1; CSA A23.3-94, 10.1.1 
23 ACI 318-14, 9.3.3.1; ACI 318-11, 10.3.5; ACI 318-08, 10.3.5; ACI 318-05, 10.3.5; ACI 318-02, 10.3.5 
24 CSA A23.3-14, 10.5.2; CSA A23.3-04, 10.5.2; CSA A23.3-94, 10.5.2; 
25 ACI 318-14, 13.3.4.4, 8.6.1.1; ACI 318-11, 15.10.4, 7.12.2.1; ACI 318-08, 15.10.4, 7.12.2.1; ACI 318-05, 10.5.4, 7.12.2.1; ACI 318-

02, 10.5.4, 7.12.2.1 
26 CSA A23.3-14, 15.4.1, 10.5.1.2(a), 7.8.1; CSA A23.3-04, 15.4.1, 10.5.1.2(a), 7.8.1; CSA A23.3-94, 10.5.1.2(a), 7.8.1 
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 u nv v  , Eq. 2-31 

where  

vu  = factored shear stress, 

vn = nominal shear resistance of slab, 

  shear resistance factor equal to 0.75. 

The nominal shear resistance, vn , is a sum of nominal shear resistance provided by shear reinforcement, vs , 

and nominal shear resistance, vc, provided by concrete. In spMats, vs is assumed to be zero and vc is taken as 

the smallest of vc1, vc2, and vc3, which are respectively equal to27: 

  c1 c
c

4
v 2 f '

 
   

 
, Eq. 2-32 

 s
c2 c

0

d
v 2 f '

b

 
   
 

, Eq. 2-33 

 c3 cv 4 f '  ,  Eq. 2-34 

with: 

c  =  the ratio of long side to short side of the column (or the pile), 

s  = 40 for interior, 30 for edge, and 20 for corner columns or piles, 

b0 =  perimeter of the critical section, 

d  =  average effective depth of the critical section segments (less pile embedment, if any), 

'
cf = square root of compressive strength of concrete, 

  = 

 

   

 

3
c

3 3
c

3
c

1.0, if w 135pcf 2155kg / m

0.85, if 115pcf 1840 kg / m w 135pcf 2155kg / m

0.75, if w 115pcf 1840 kg / m

 



 

 


 

Similarly for the CSA standards, factored shear stress, vf, is checked against factored shear resistance, vr, 

which only takes into account concrete shear resistance calculated as the minimum of the following three 

values: 

 c1 c c
c

0.4
v 0.2 f '

 
    

 
, Eq. 2-35 

 s
c2 c c

0

d
v 0.2 f '

b

 
    
 

, Eq. 2-36 

 c3 c cv 0.4 f '   , Eq. 2-37 

for the CSA A23.3-94 Standard28, and 

                                                           

27 ACI 318-14, 22.6.5.2, 22.6.5.3; ACI 318-11, 11.11.2.1; ACI 318-08, 11.11.2.1; ACI 318-05, 11.12.2.1; ACI 318-02, 11.12.2.1 
28 CSA A23.3-94, 13.4.4 
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 c1 c c
c

0.38
v 0.19 f '

 
    

 
, Eq. 2-38 

 s
c2 c c

0

d
v 0.19 f '

b

 
    
 

, Eq. 2-39 

 c3 c cv 0.38 f '   , Eq. 2-40 

for the CSA A23.3-04 and CSA A23.3-14 standards29. Factor s  equals 4 for interior columns, 3 for edge 

columns, and 2 for corner columns for all CSA standards. Factor   accounts for low density concrete and is 

equal to:  

  = 

 

   

 

3
c

3 3
c

3
c

1.0, if w 2150kg / m 134.2pcf

0.85, if 1850kg / m 115.5pcf w 2150kg / m 134.2pcf

0.75, if w 1850kg / m 115.5pcf

 


 




 

Also, for interior column and piles, the value of effective depth, d, in Eq. 2-38 through 2-40 will be 

multiplied30 by factor1300 /(1000 d) . 

The projection of the critical section to the middle surface of the slab is a polygon located so its perimeter b0 

is a minimum and the distance between its segments and the column is not less than a half of slab effective 

depth. For circular columns and piles, the critical section is approximated by a polygon with ten segments per 

quarter. The depth of each segment can be different depending on the depth of the slab at the location of the 

segment. In the case of edge or corner columns and piles, segments of the critical section that lie outside of 

the slab are disregarded.  

For a section defined as such, the area Ac, the coordinates  c cx , y  of the centroid, and Jxx, Jyy, Jxy properties 

are calculated. Force (Puz) and moments (Mux and Muy) applied at the center of the column (pile) are 

transformed to the centroid of the critical section. The unbalanced moments to be transferred by eccentricity 

of shear are: 

 vx vx ux uz f cM (M P (y y ))    , Eq. 2-41 

 vy vy uy uz f cM (M P (x x ))    , Eq. 2-42 

where xf and yf are the coordinates of the column (pile) center. If Bx and By denote the dimensions of the 

critical section then the fractions of the unbalanced moments transferred by eccentricity of shear can be 

calculated as31 

 vx

x

y

1
1

B2
1

3 B

  



, Eq. 2-43 

 vy

y

x

1
1

B2
1

3 B

  



. Eq. 2-44 

At each vertex of the critical section, the factored shear stress vu (vf for CSA) can be calculated from the 

formula32: 

                                                           

29 CSA A23.3-14, 13.3.4; CSA A23.3-04, 13.3.4 
30 CSA A23.3-14, 13.3.4.3; CSA A23.3-04, 13.3.4.3 
31 ACI 318-14, 8.4.4.2, 8.4.2.3.2; ACI 318-11, 11.11.7.1, 13.5.3.2; ACI 318-08, 11.11.7.1, 13.5.3.2; ACI 318-05, 11.12.6.1, 13.5.3.2; 
ACI 318-02, 11.12.6.1, 13.5.3.2; CSA A23.3-04, Eq. 13-8; CSA A23.3-94, Eq. 13-7 
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   vyuz vx
u

c xx yy

MP M
v x, y y x

A J J
   , Eq. 2-45 

where x and y are the vertex coordinates relative to principal axes x and y. If axes x and y are centroidal (not 

principal), i.e. xyJ 0 , a more general formula shown below is used 

   vx yy vy xy vy xx vx xyuz
u 2 2

c xx yy xy xx yy xy

M J M J M J M JP
v x, y y x

A J J J J J J

 
  

 
, Eq. 2-46 

except for CSA A23.3-04 and CSA A23.3-14 standards33 in which a formula consistent with Eq. 2-45 is 

stipulated for centroidal (not principal) axes. 

Piles are allowed to be embedded into the slab, which effectively decreases the average effective depth of the 

critical section segments.  

The vertex that governs the punching shear check is the one where the ratio of factored shear stress to shear 

resistance is the highest. 

Program Results  

The program output is organized into tables that may be optionally viewed, printed, or saved in a file. 

Furthermore, the tables may be fully or partially output for all or for only selected nodes, members, and 

combinations.  

The program distinguishes between individual (service or ultimate) combination results and envelope results 

(which include the maximum values from all load combinations).  

Force Vector:  

This table is output for individual service and individual ultimate load combinations. It lists the nodal load 

vector that is actually used by the program for each load combination. The force, Fz, moment about X-axis, 

Mx, and moment about Y-axis, My, at each node includes the effects of loads concentrated at the node and the 

discretized effects of uniform surface loads. Positive forces are applied in the direction of the positive Z-axis 

(upward) and positive moments are determined using the right-hand rule.  

Displacement Vector:  

This table is output for individual service and individual ultimate load combinations. It lists the displacement 

vector for each load combination. The table lists the displacement, Dz, and the two rotations about the X- and 

Y-axis, Rx and Ry, respectively. Positive displacement is in the positive Z-direction, and the right-hand rule is 

used to determine the direction of the rotations.  

Reactions:  

This table is output for individual service and individual ultimate load combinations. The table lists reactions 

for the nodes with soil, spring, pile, restraints, and slaved nodes. Positive translational reactions (forces) are in 

the direction of the positive axes and positive rotational reactions (moments) are determined using the right 

hand rule. The table also reports the sum of forces and moments (with respect to center of gravity) for applied 

loads and reactions due to restraints, slaved nodes, soil springs, nodal springs, and piles. 

Soil Displacements and Pressures:  

This table is output for individual service load combinations. For the elements with specified soil, the 

displacement and pressure at all four nodes are listed. Since the soil is assumed tensionless, the pressure is set 

to zero for positive (upward) displacements. 

                                                                                                                                                                                

32 CSA A23.3-94, 13.4.5.5 
33 CSA A23.3-14, 13.3.5.5; CSA A23.3-04, 13.3.5.5 
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Element Nodal Moments:  

This table is output for individual ultimate load combinations. At each of the four nodes of the element (i, j, k 

and l), listed are the bending moments (Mxx and Myy), the twisting moment (Mxy) the equivalent principal 

moments (Mr1 and Mr2), along with the principal angle, and equivalent design bending moments (Mux and 

Muy) at the top and bottom. Note that Mxx and Myy are positive when they produce tension at the top and are 

referred to as moments along the X and Y-axes, respectively. For more information about these moments and 

the sign convention, refer to Fig 2-7 Element Nodal Moments.  

Punching Shear: 

For each column and pile, punching shear stresses resulting from ultimate load combinations are listed. For 

each ultimate load combination, the report includes geometrical properties of critical sections and shear 

stresses at critical points, i.e., vertexes at which the ratios of factored shear stress to shear resistance are the 

highest. 

Nodal Displacement Envelopes:  

This table lists the maximum vertical displacement, Dz, from all service load combinations, along with the 

governing combination. Positive displacements are upward in the positive Z-direction.  

Reaction Envelopes:  

The table lists envelope (minimum and maximum) reactions for the nodes with soil, spring, pile, restraints, 

and slaved nodes from all service load combinations and ultimate load combinations along with the governing 

load combinations labels. 

Soil Displacement and Pressure Envelopes:  

For the elements with specified soil, this table lists the maximum displacements and pressures resulting from 

all service load combinations and all four element nodes. The governing load combination and the governing 

element node are also listed. 

Element Top Moment Envelopes:  

At each node of each element, the table reports extreme positive values of Wood-Armer design bending 

moments, Mux and Muy, in X and Y direction respectively, together with the moments Mxx, Myy, Mxy, Mr1, angle 

of the major principal direction, and the ultimate load combination that produces the extreme design 

moments. 

Element Bottom Moment Envelopes:  

At each node of each element, the table reports extreme negative values of Wood-Armer design bending 

moments, Mux and Muy, in X- and Y-directions, respectively, together with the moments Mxx, Myy, Mxy, Mr1, 

angle of the major principal direction, and the ultimate load combination that produces the extreme design 

moments. 

Element Top Design Moment and Reinforcement Envelopes:  

When steel design is based on average moment within an element, the table reports the ultimate load 

combination that produces the extreme average value of positive Wood-Armer design bending moments, Mux 

and Muy, together with the values of extreme design moments and the corresponding steel area requirement. 

When steel design is based on maximum moment within an element, the table reports the node and the 

ultimate load combination for which the values of positive Wood-Armer design bending moments, Mux and 

Muy, are extreme together with the values of extreme design moments and the corresponding steel area 

requirement. 
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Element Bottom Design Moment and Reinforcement Envelopes: 

When steel design is based on average moment within an element, the table reports the ultimate load 

combination that produces the extreme average value of negative Wood-Armer design bending moments, Mux 

and Muy, together with the values of extreme design moments and the corresponding steel area requirement. 

When steel design is based on maximum moment within an element, the table reports the node and the 

ultimate load combination for which the values of negative Wood-Armer design bending moments, Mux and 

Muy, are extreme together with the values of extreme design moments and the corresponding steel area 

requirement. 
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Chapter 3 – spMats Interface 

spMats Interface 

The spMats interface is made up of the elements as illustrated below. The content of the interface’s MAIN 

WINDOW changes depending on what you select from any menu displayed on the MENU BAR or from any 

button displayed in the TOOL BAR. In the illustration below, the MAIN WINDOW is shown contained within a 

blue frame.  

 

Control Menu: 

The CONTROL MENU is located in the upper-left corner of the screen. It includes commands for restoring, 

moving, sizing, minimizing, maximizing, and closing the program.  

Title Bar: 

The TITLE BAR displays the name of the program (spMats in this case), along with the path and filename of 

the current data file in use. If the file is new and has not yet been saved, the word “Untitled” is displayed in 

the title bar. 

Min/Max/Close Buttons: 

The MIN/MAX/CLOSE buttons are located in the upper-right corner of the screen. The MINIMIZE button ( ) 

shrinks the program to the Windows Taskbar. The MAXIMIZE button ( ) enlarges the program so that it 

covers the entire desktop. After the program has been maximized (takes up the entire screen), the MAXIMIZE 

button ( ) is replaced by the RESTORE button ( ). Clicking on the RESTORE button ( ) returns the 

program to its original size. 
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Tool Bar:  

The TOOL BAR is located on the left side of the screen. There are a total of 5 buttons on the TOOL BAR. Each 

one displays various information in the MAIN WINDOW of the program. The TOOL BAR provides access to 

commands that are also accessible via the MENU BAR. The active tool bar’s text will appear in yellow 

(highlighted).  

Menu Bar:  

The MENU BAR is located directly beneath the TITLE BAR. There are a total of 6 distinct drop-down menus 

accessible from the MENU BAR. The majority of commands appearing in the drop-down menus are also 

accessible via the program’s MAIN WINDOW area.  

Status Bar:  

The STATUS BAR is located directly beneath the program’s MAIN WINDOW area. It displays important 

information such as current units, cursor position, and helpful messages.  

The MAIN WINDOW is made of 4 distinct areas as illustrated here: 

 

Tabs (on Main Window):  

The TABS are located on the MAIN WINDOW and vary depending on the button you click on the TOOL BAR or 

on the command that you select from one of the drop-down menus. Each TAB surfaces different 

GRAPHICS/INPUT AREAS for recording and inputting data as it relates to each project. 

Graphics/Input Area (on Main Window):  

The GRAPHICS/INPUT AREA covers most of the MAIN WINDOW. This is where the graphical editing and data 

input are done.  

Item Listing Area (on Main Window):  

The ITEM LISTING AREA appears on the right side of the MAIN 

WINDOW. The items appearing in the listing vary depending on the 

TAB that you select. Certain items appearing in listings have “plus” 

Retracted List Expanded List 
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or “minus” signs indicating that the list is expandable or retractable, respectively. All first-level items, such as 

Thickness, Soil, Concrete, etc., are expanded by default for easy access to the defined sub-items. 

Information Area (on Main Window):  

The INFORMATION AREA appears in the lower-right corner of the MAIN WINDOW. This area displays helpful 

information and values pertinent to the active item that you select in the ITEM LISTING AREA.  

Zooming and Translating while Assigning  

While using any of the Assign menu or ASSIGN tool bar commands, the mouse action is reserved to select or 

deselect nodes and elements. Note, however, that you may still zoom or translate the graphical image without 

selecting the corresponding commands from either the View menu or the bottom of the MAIN WINDOW. 

However, ZOOM and PAN disable assignment and have to be released to get back to assign mode.  

File Menu  

The File menu gives access to file operations, printing operations, and to exiting the spMats program. 

New (Ctrl+N) 

Clears any input data and returns the data to the default values so that a new input file 

may be created. 

Open (Ctrl+O) 

Opens an existing input file. 

Save (Ctrl+S) 

Saves the changes made to the current input file.  

Save As  

Enables you to name or rename an input file.  

Revert  

Discards any changes to the input file and returns to the most recently saved version of the input file. This 

option will only be available if the input file has been previously saved and there have been modifications 

done on the input file since. Do not save the input file immediately prior to reverting because this will result 

in reverting to the very same input data as before reverting. 

Delete Results 

Deletes the output data.  

Print Results  

Provides a printout of the input and output data.  

Print Screen (Ctrl+P) 

Prints the graphical image displayed in the GRAPHICS/INPUT AREA of the MAIN WINDOW. 

Import / Grid… 

Imports grid definition from an ASCII (TXT) file. 
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Import / Loads… 

Imports load definitions from an ASCII (TXT) file. 

Import / Load Combinations… 

Imports load combination definitions from an ASCII (TXT) file. 

Export / Mat Plan to DXF File… 

Exports mat plan view to a DXF file for easier integration with drafting and modeling software. 

Recent Data File List 

Provides quick access to recently open data files. 

Exit  

Ends the spMats program. 

Define Menu 

The Define menu provides access to commands used to define all of the input data. The information you 

input via the commands found under the Define menu will be used when assigning properties, loads, and 

restraints to the model and then for analyzing the model and calculating the required steel area in the slab. 

General Info  

Defines and records the particulars on the project including project name and description, 

project date and time, and engineering parameters including units of measure and design 

code. 

Grid  

Defines the grid lines that make up the rectangular grid system. The slab model is defined 

based on the grid system specified here. This command also gives access to the grid 

preferences where you are able to show/hide node and element numbers, select between 

dotted or solid grid lines, and specify the coordinate precision.  

Library  

Provides access to libraries from which data items can be imported to the current project or where data items 

can be recorded so they can be reused in other projects.  

Thickness  

Defines the plate element thickness entries.  

Concrete  

Defines the concrete material properties including compressive strength, unit weight, Young’s modulus, and 

Poisson’s ratio. For CSA A23.3-04 and CSA A23.3-14 design standards, it also allows distinguishing 

between cast-in-place and pre-cast concrete. 

Soil  

Defines soil properties including subgrade modulus and allowable pressure. 

Reinforcing Steel  

Defines reinforcing steel material properties including yield strength and Young’s modulus.  
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Design Parameters  

Defines the parameters that set the criteria for designing the slab. These parameters include minimum 

reinforcement ratio and distance of reinforcement from top and from bottom in both directions.  

Columns  

Defines column properties including type and cross section dimensions.  

Nodal Springs  

Defines nodal spring entries including the spring constant (K).  

Slaved Nodes  

Defines groups of slaved degrees of freedom (Dz, Rx, Ry). 

Piles  

Defines pile properties including pile type, cross section dimensions, pile length, material properties, and soil. 

These properties are used to calculate the equivalent spring constant for a pile.  

Load Combinations  

Defines load combinations for both service- and ultimate-levels under which the model is to be analyzed and 

designed. 

Loads  

Defines element and nodal load entries for up to 26 load cases (A to Z).  

Assign Menu 

The Assign menu provides access to commands used to input the model geometry and 

assign the defined properties and loads to the nodes and elements. All assignments are done 

graphically. 

Thickness  

Assigns the various plate element thicknesses to the defined grid. 

Concrete 

Assigns the various concrete properties to the defined elements. 

Soil  

Assigns the various soil properties to the defined elements.  

Reinforcing Steel  

Assigns the various reinforcing steel properties to the defined elements.  

Design Parameters  

Assigns the various design parameters to the defined elements.  

Columns  

Assigns the various columns to the nodes.  
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Nodal Springs  

Assigns the various nodal springs to the nodes.  

Slaved Nodes  

Assigns the various groups of slaved degrees of freedom to nodes sharing the same displacements in the 

direction of the slaved degrees of freedom defined in the groups. 

Restraints 

Assigns restraints for restraining nodal degrees of freedom.  

 Piles  

Assigns the various piles to the nodes.  

Surface Loads  

Assigns the various surface loads to the elements.  

Nodal Loads  

Assigns the various nodal loads to the nodes. 

Solve Menu 

The Solve menu provides access to solution control parameters, to executing the analysis and design, and to 

viewing results in text and graphical representations. 

Execute (F5) 

Executes the solver portion of the program.  

View Results (F6) 

Provides access to the results (text mode) after a successful run.  

View Contours (Shift+F6)  

Provides access to graphical representations of results after a successful run. 

View Menu  

The View menu provides access to commands used to manipulate the Graphical display 

and to control what is to be displayed in the GRAPHICS AREA. 

3D  

Shows the model in 3D isometric view. 

Status Bar  

Toggles the Status Bar at the bottom of the screen on or off.  
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This Menu (Ctrl+F12) 

Toggles the Menu Bar at the top of the screen on or off.  

Reset 

Resets the graphical window to the default view. 

Zoom-in 

Sets the graphical window to zoom-in mode. 

Zoom-out 

Sets the graphical window to zoom-out mode. 

Rotate 

Sets the graphical window to rotate mode. 

Pan 

Sets the graphical window to pan mode. 

Options Menu 

The Options menu provides access to commands used to define program settings and to 

display model information. 

Startup Defaults  

Provides access to saving defaults such as units of measurement and design code so that the system knows to 

use these for new input files. Controls options for default definitions loaded from templates and default 

assignment options. 

Autosave  

Provides the option to have the system automatically save data periodically without you having to necessarily 

select the File / Save command.  

Display 

Provides display settings such as the font used in displaying node and element numbers, the color settings of 

the graphical display area, and various options for the 3D View and 2D View windows. 

Statistics  

Provides model information such as the total number of nodes, elements, and definitions. 

Help Menu  

The Help menu provides access to support resources and information on the spMats 

version. 

spMats Help 

Provides access to all available help topics. Click on any topic and a help screen will 

appear with information about that item. 
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spMats Manual 

Opens the spMats Manual in the default PDF viewer. 

Check for Updates 

Checks if a newer version of the program is available. Internet connection is required. 

About spMats 

Shows the version number of the program, the licensing information, and the copyright information. In the 

case of a trial license, the expiration date is given as well as the locking code which is needed to obtain a 

standalone license. 

 



 

Chapter 4 – Operating spMats 

Operating spMats 

In this chapter, the sections follow the order in which commands and options appear under the subsequent 

menu items.  

We begin with those found under the File menu and end with those under the Help menu. 

Many of the commands and options that appear under these menus are also accessible by other methods. 

Consequently, these other methods are also explained.  

Creating New Data File  

When spMats is loaded, the program is ready to begin receiving input for a new project. Until you save the 

file, the data will not have a filename associated with it, and the title bar will display the word “Untitled” as 

illustrated here:  

 

 From the File menu, choose New. This clears the screen in preparation for a new project or data entry 

file and returns the program to its default settings.  

 If existing data on an open project has been changed prior to executing the New command, the program 

will display the following message box inquiring whether you wish to save the data on the open project 

or data file before creating a new file: 

 

Opening Existing Data File 

From the File menu, choose Open to have the program display the following dialog box:  

 

All files with MA8 extensions contained in the current drive and directory are displayed in the listing.  

To open a MA8 file that exists in another drive or directory, use the LOOK IN drop-down list and locate the 

folder where the file exists. Once you locate the folder, the file will appear in the listing. From the white 
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listing area, either select the file that is to be opened and click on the OPEN button, or simply double-click on 

the respective file. Alternatively, an input file can be opened by spMats if the file is drag-and-dropped onto 

the program window or if the file pathname is provided as a command line parameter when invoking spMats 

from the command prompt.  

To open a MA7 or a MA6 file, which were created by the previous versions (v7.xx and v6.xx), select this 

extension from FILES OF TYPE drop-down list. This allows displaying files with such file format. 

You can also open data files with MAT extension that were created by the older (5.10/5.20) versions of the 

program. Use FILES OF TYPE drop-down list to change the type of data files displayed in the OPEN dialog box 

and browse to the file you want to open. 

The data files which were imported from previous versions can be saved under new file format with extension 

MA8. 

Saving Input File 

spMats files are saved in binary format with MA8 extensions. When information in a data file is modified, 

and until the file is saved, the Title bar will display the word “Modified” as illustrated here: 

 

To save your data with the same filename:  

 If you are editing an already existing data file and that file has previously been saved (i.e., the TITLE BAR 

displays a filename), then from the File menu, choose the Save command. The changes will be recorded 

under the same filename and the old data file will be overwritten.  

To save your data for the first time or to give an existing data file a new filename:  

 If you are saving a new data file for the first time (i.e. the TITLE BAR displays “Untitled”), then when you 

choose Save or Save As from the File menu, the following SAVE AS dialog box will appear:  

 

 Similarly, if you are editing an already existing data file and that file has previously been saved (i.e., the 

TITLE BAR displays a filename), and you wish to record the changes under a different filename, then 

choose Save As to have the program surface the SAVE AS dialog box.  

 Use the SAVE IN drop-down list and locate the folder where the file is to be saved. Once you locate the 

folder, the white listing area will display any other spMats files that have been saved in that folder. 

Double-click in the FILE NAME text box and type a filename. Choose the SAVE button to finish recording 

the data file. (You need not enter an extension since, by default, the program will affix the MA8 

extension to the filename.) 
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Reverting to Last Saved Input File 

 If you have begun to make changes to a data file that has previously been saved, (i.e., the TITLE BAR 

displays a filename), and you suddenly wish to discard all the changes and revert back to the previously 

saved data file, then select Revert from the File menu.  

 The program will verify your intention with the following message box: 

 Click on YES only if you are certain that you wish to discard all changes since the 

last time the file was saved. If you are not sure, another option would be to actually 

save the file under a different name, and then re-open the old data file.  

Note: If Autosave is enabled, the program will revert to the data previously saved by the Autosave function. 

Printing Results 

 From the File menu, choose Print Results to have the program surface the REPORTS folder as illustrated 

here: 

 

Alternatively, you can click on the  button located on the toolbar, and then on the REPORTS 

tab.  

 Place a checkmark in the TITLE PAGE check box if you wish to include a title page with the printout.  

From the RANGE group, you may select the ranges of nodes and elements to be printed for each of the 

tabular output blocks.  

NODES: Will print all or selected nodal data including coordinates, assignments and loads.  

ELEMENTS: Will print all or selected element indexes, assignments, and loads. 

 From the INPUT ECHO group, you may select the tables to be printed…  

DEFINITIONS: Will print all the input data entered using the Define menu commands.  

 Select the RESULTS to be printed. For more information about the output tables, see Program Results in 

Chapter 2.  

 In the SERVICE group, select whether to display SPRING DISPLACEMENT & REACTIONS and/or ELEMENT 

DISPLACEMENT & PRESSURE. If check marked, the program will display the respective results under the 

service load calculations.  
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 In the ULTIMATE group, select whether to display ELEMENT NODAL MOMENTS. If check marked, the 

program will display the respective results under the ultimate load calculations.  

 Place a check mark in PUNCHING SHEAR if you wish the output to include the respective results of the 

Punching Shear computations.  

 In the NODES and ELEMENTS groups, select the ALL check box for a comprehensive output. For selective 

printing, specify the ranges of nodes and/or elements to print.  

 In the COMBINATIONS group, select ALL to print for all service and ultimate load combinations. To print 

for specific combinations, choose the SELECT button to have the program surface the following dialog 

box:  

 Highlight the combinations from the DEFINED 

COMBINATIONS list, and click on the  button to 

move them to the SELECTED COMBINATIONS list. 

Repeat for all load combinations you wish to select 

under both SERVICE and ULTIMATE. To remove a 

selected combination, highlight the combination 

from the SELECTED COMBINATIONS list and click on 

the  button. Click on the OK button when done. 

 Choose the ENVELOPES that are to be included in the 

output (printout). 

 Alternatively, the CHECK ALL button can be used to 

include all items in the printout. Clicking on the 

CLEAR ALL button will clear all selected items.  

 In the PRINT TO group, specify whether the output should be 

sent to the default printer or if it should be saved to a file. If 

FILE is selected, click on the  button to specify what it 

should be named and where it should be saved. 

 Click on the PRINT button.  

Printing the Screen 

 From the File menu, choose Print Screen to have the program surface the standard Windows print 

dialog box similar to the following: 

 

 This command will print the GRAPHICS AREA in a “what you see is what you get” format. In order for 

this command to be enabled, the 3D View folder must be the active folder as shown here:  
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Export 

 The model geometry created in spMats can be exported to CAD programs using the File/Export/Mat Plan 

to DXF File command. You may have to scale or zoom the drawing in the CAD program to view it at a 

suitable scale. 

 From the File menu, select Export/Mats Plan to DXF File. This dialog box appears: 

 

 Use the SAVE IN drop-down list and locate the folder where the file is to be saved. Once you locate the 

folder, the white listing area will display any other DXF files that have been saved in that folder. If you 

want to use a file name other than the default (same as input file name), double-click in the FILE NAME 

text box and type a filename. (You need not enter an extension since, by default, the program will affix 

the DXF extension to the filename.) 

 Choose the SAVE button to finish exporting. 

Exiting Program  

From the File menu, choose Exit. If the data file has been modified since the last time it was saved, i.e., the 

word (Modified) appears in the TITLE BAR, then the program will display the following message box:  
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Click on YES to save. NO will exit without saving, and CANCEL will ignore the Exit command and return you 

to the data file. 

Defining General Info 

 From the Define menu, choose General Info to have the program surface the DESCRIPTION folder as 

illustrated below.  

Alternatively, you can click on the  button located on the toolbar, and then on the DESCRIPTION 

tab.  

 Enter the Project Name and any details/notes describing the project. The Project Date And Time will 

default to the instance you started the project however you are free to change it. These fields help 

organize and identify data sets.  

 From the UNITS options group, choose the applicable units of measure and from the CODE options group, 

select the appropriate design code.  

 

Defining Grid  

 The rectangular grid system is defined by inputting the coordinates of the X- and Y-grid lines. Note that 

it is possible to generate multiple, equally spaced grid lines as well as individual ones at any location.  

 From the Define menu, choose Grid to have the program surface the GRID folder as illustrated here: 
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Alternatively, you can click on the  button located on the toolbar, and then on the GRID tab.  

 If you wish, you can enter a name and description for the grid. To do this, 

double-click on DESCRIPTION… found in the ITEM LISTING AREA. The 

program will surface the following dialog box:  

 Enter a NAME and DESCRIPTION or note and click on OK.  

To Enter Grid Lines Individually:  

 Double-click on SET UP… found in the ITEM LISTING AREA to have the 

program surface the figure to the right. 

 Select the grid direction from the respective option group, X-

Direction or Y-Direction. Grids in the X-Direction are perpendicular 

to the X-axis and those in the Y-Direction are perpendicular to the 

Y-axis. 

 Enter a grid line coordinate. This value, in feet or meters, represents 

the orthogonal distance from the origin to the grid line. 

 Choose the ADD button to add the grid coordinate to the listing area.  

 Repeat the two steps above for each grid line.  

 If you wish to enter grids separately and individually in the other 

direction, then repeat the above four steps. If you wish to copy the 

grids you just input in one direction so that they are mirrored in the 

other direction, choose the COPY button. For example, if you just 

finished defining the grid lines in the X-Direction, then the COPY 

button will copy all X-grid lines to Y-Direction.  

Note: As grid lines are added, new elements may be generated automatically which increases the size of the 

model. In order to solve large models on systems with limited memory resources34, the user may need to 

delete some grid lines or elements later to ensure that the model can be solved within the currently available 

memory. 

                                                           

34 See System Requirements in Chapter 1 
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To Delete Grid Lines:  

 Select the grid line you wish to delete and choose the DELETE button.  

To Edit the Position of a Grid Line:  

 Select the grid line you wish to edit, change its location by overwriting the value that is displayed in the 

COORDINATE text box, and choose the MODIFY button.  

To Generate Grid Lines:  

Grid Lines that are spaced at equal intervals may be generated by inputting the coordinate (distance from the 

origin) of the first grid line, the number of grid lines and the spacing between two consecutive grid lines.  

 With the GRID tab surfaced, double-click on GENERATE… 

found in the ITEM LISTING AREA to have the program 

surface the following: 

 To generate grids in the X-direction, place a checkmark in 

the X-Direction checkbox. To generate grids in the Y-

Direction, place a checkmark in the Y Direction check 

box. Recall that grids in the X-Direction are perpendicular 

to the X-axis and those in the Y-Direction are 

perpendicular to the Y-axis. 

 For each direction, enter the coordinate of the first grid line to be generated, the number of grid lines to 

be generated (including the first one), and the spacing between two consecutive grid lines.  

 Click on the GENERATE button to have the program generate the respective grid lines.  

Note: As grid lines are added, new elements may be generated automatically which increases the size of the 

model. In order to solve large models on systems with limited memory resources35, the user may need to 

delete some grid lines or elements later to ensure that the model can be solved within the currently available 

memory. 

To Import Grid Lines from Text File 

 Double-click on IMPORT… found in the ITEM LISTING AREA or, alternatively, choose File / Import / 

Grid… to have the program display the following OPEN dialog box: 

 

 All files with the TXT extension contained in the current drive and directory are displayed in the FILE 

NAME list box. 

 To open a file that exists in another drive or directory, select the drive or directory you want from the 

LOOK IN drop-down list. 

 From the FILE NAME list box, select the file to be opened, or simply type its name in the text box.  

                                                           

35 See System Requirements in Chapter 1 
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 Choose the OPEN button. 

Note: Refer to Import File Formats section of the Appendix for description of the grid import file. 

To Remove all Grid Lines:  

 Double-click on RESET… found in the ITEM LISTING AREA to have the 

program surface the following: 

 Note that if you choose to proceed, any material properties, loads, etc. that 

have already been assigned will have to be re-assigned.  

 After confirming your intention, all the grid lines will be removed.  

To Choose Grid View Preferences:  

 Double-click on PREFERENCES found in the ITEM LISTING AREA to have 

the program surface the following: 

 If you wish for the grid to display the NODE NUMBERS and/or the 

ELEMENT NUMBERS, place checkmarks in the appropriate box(es).  

 Select the style of the grid line, SOLID or DOTTED.  

 Specify the COORDINATE PRECISION. This value relates to the precision 

of the cursor location. (Recall that the location of the cursor is displayed in the STATUS BAR.)  

 Click on OK to register your selections/changes.  

To View Grid Coordinates:  

In the right ITEM LISTING AREA, click on the symbol next to the X GRID or Y GRID item(s) to expand the 

list of grid coordinates. Notice how the grid that is selected appears in red in the GRAPHICS/INPUT AREA. 

 

Managing Libraries  

The following items may either be recorded during the definition of the project, or they may be assigned to 

the project from existing libraries:  
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– Grids – Nodal springs  

– Element thickness – Slaved nodes  

– Soil properties – Piles  

– Concrete properties – Concentrated loads  

– Reinforcement properties – Surface loads  

– Design parameters – Load combinations  

– Columns  

Newly defined items may also be added to existing libraries, or may be saved as part of a new library for use 

on any future projects.  

Items may also be extracted and applied to the current project from numerous libraries (i.e., Element 

thickness 1 and 2 from Library A, and element thickness 3 and 4 from Library B). 

The file extension of spMats library files is: *.MATLIB  

 From the Define menu, choose Library to have the program surface the LIBRARIES folder as illustrated 

below:  

 

Alternatively, you can click on the  button located on the toolbar, and then on the PROPERTIES tab. 
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To Assign Items from a Library to the Current Project:  

 Click on the  button to have the following 

Windows OPEN dialog box appear: 

 Locate the library file and click on OPEN to return focus 

to spMats. Notice how the contents of the selected 

library appear in the listing under CURRENT LIBRARY. 

 Click on the  symbol next to various items to expand 

their contents. The items that will subsequently appear 

are items that have been pre-defined. 

 Select the item and click on the  arrow to copy the 

item and to paste it into the current project. Any items 

copied over now become available for assigning. 

 Repeat the above steps to select items from additional libraries. 

To Create and Save a Library:  

 Click on the  symbol next to the items appearing 

under the Current Project listing to expand their 

contents.  

 Locate the specific items defined in the current 

project and click on the  arrow to copy the item 

and to paste it into the current library.  

 If there are items in the library that you would like to 

remove, simply highlight (click on) them and click on 

the  icon. 

 To overwrite the library, click on the  

button. Any items copied over from the current 

project now become part of the saved library.  

 To save the library as new, click on the  button. Any items copied over from the current 

project now become part of the new library. 

Defining Material Properties 

Material properties such as:  

 Element thickness, 

 Soil modulus (Ks) and allowable pressure (Qa), 

 Concrete compressive strength (
'

cf ), unit weight (w), Young’s modulus (Ec), and Poisson’s ratio (v), 

 Reinforcement yield strength (fy), Young’s modulus (Es), minimum reinforcement ratio and re-bar 

location, 

 Column type (round or rectangular) and dimensions, must be defined before they can be assigned to the 

elements on the grid.  

 From the Define menu, choose Thickness, Concrete, Soil, Reinforcing Steel or Design Parameters to 

have the program surface the PROPERTIES folder as illustrated here: 
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Alternatively, you can click on the  button located on the toolbar, and then on the 

PROPERTIES tab. 

To Define Element Thickness:  

 From the Define menu select Thickness, or if the PROPERTIES folder is displayed, click on THICKNESS 

found in the ITEM LISTING AREA to have the program surface the Thickness input screen: 

 

 Enter a thickness label or ID in the LABEL text box and enter the corresponding thickness in the 

THICKNESS text box.  

 Click on the ADD button to add the entry to the list box.  

 Repeat the two steps above for each thickness entry.  

 To edit an entry, select it from the list box, modify its value(s) in the text box(es), and click on the 

MODIFY button to register the changes.  

 To delete a thickness entry, select it from the list box and click on the DELETE button.  

To Define Soil Properties:  

 From the Define menu select Soil, or if the PROPERTIES folder is displayed, click on Soil found in the 

ITEM LISTING AREA to have the program surface the SOIL input screen:  
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 Enter a label or Soil ID in the LABEL text box and enter the corresponding SUBGRADE MODULUS (Ks) and 

soil’s ALLOWABLE PRESSURE (Qa) in the corresponding text boxes.  

 Click on the ADD button to add the entry to the list box.  

 Repeat the two steps above for each soil entry.  

 To edit an entry, select it from the list box, modify its value(s) in the text box(es), and click on the 

MODIFY button to register the changes.  

 To delete a soil entry, select it from the list box and click on the DELETE button. 

To Define Concrete Properties:  

 From the Define menu select Concrete, or if the PROPERTIES folder is displayed, click on CONCRETE 

found in the ITEM LISTING AREA to have the program surface the CONCRETE input screen: 

 

 Enter a label or Concrete ID in the LABEL text box and enter the corresponding Compressive Strength 

(
'

cf ) and UNIT WEIGHT (w) in the respective text boxes.  

 The YOUNG’S MODULUS of elasticity (Ec) is calculated automatically and will display a result that is 

respective of the equations in the selected Code. Note that the value of Ec can be modified if it differs 

from the calculated value.  

 Enter the POISSON’S RATIO for the concrete and click on the ADD button to add the entry to the list box.  

 Repeat the three steps above for each concrete entry.  

 To edit an entry, select it from the list box, modify its value(s) in the text box(es), and click on the 

MODIFY button to register the changes.  

 To delete a concrete material entry, select it from the list box and click on the DELETE button.  

To Define Reinforcing Steel Properties:  

 From the Define menu select Reinforcing Steel, or if the PROPERTIES folder is displayed, click on 

REINFORCEMENT found in the ITEM LISTING AREA to have the program surface the REINFORCEMENT 

input screen:  
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 Enter a label or Reinforcement ID in the LABEL text box and enter the corresponding Yield Strength (fy) 

and the YOUNG’S MODULUS of elasticity (Es) for the steel.  

 Click on the ADD button to add the entry to the list box.  

 Repeat the two steps above for each reinforcement entry.  

 To edit an entry, select it from the list box, modify its value(s) in the text box(es), and click on the 

MODIFY button to register the changes.  

 To delete a reinforcement material entry, select it from the list box and click on the DELETE button. 

To Define Design Parameters:  

 From the Define menu select Design Parameters, or if the PROPERTIES folder is displayed, click on 

DESIGN PARAMETERS found in the ITEM LISTING AREA to have the program surface the DESIGN 

PARAMETERS input screen, shown here:  

 

 Enter a label or ID in the LABEL text box and enter the corresponding MINIMUM REINFORCEMENT RATIO 

as a percentage of the gross area per layer.  

 Specify the bar location for the TOP LAYER and BOTTOM LAYER reinforcement running in the X and Y 

directions. For top bars, the location is measured from the slab top to the centroid of the bar. For bottom 

bars, the location is measured from the slab bottom to the centroid of the bar.  

 Click on the ADD button to add the entry to the list box.  

 Repeat the three steps above for each design entry.  

 To edit an entry, select it from the list box, modify its value(s) in the text box(es), and click on the 

MODIFY button to register the changes.  

 To delete a design parameter entry, select it from the list box and click on the DELETE button.  

To Define Column Dimensions:  

 Surface the PROPERTIES folder and click on COLUMN DIMENSIONS found in the ITEM LISTING AREA to 

have the program surface the COLUMN DIMENSIONS input screen: 

 

 Enter a label or Column ID in the LABEL text box and select the TYPE of COLUMN (Round or Rectangle) 

from the drop-down list.  



 

Operating spMats  4-15 

 Enter the dimensions in the respective text box(es). If you select "Round" from the TYPE drop-down list, 

then enter the column’s diameter as the X-DIM.  

 Click on the ADD button to add the column to the list box.  

 Repeat the three steps above for each column entry.  

 To edit an entry, select it from the list box, modify its value(s) in the text box(es), and click on the 

MODIFY button to register the changes.  

 To delete a column entry, select it from the list box and click on the DELETE button.  

Defining Restraints 

 From the Define menu, choose Nodal Springs, Slaved Nodes or Piles to have the program surface the 

RESTRAINTS folder as illustrated below: 

 

Alternatively, you can click on the  button located on the toolbar, and then on the RESTRAINTS 

tab.  

To Define Nodal Springs:  

 From the Define menu, select Nodal Springs, or if the RESTRAINTS folder is displayed, click on NODAL 

SPRINGS found in the ITEM LISTING AREA to have the program surface the Nodal Springs input screen.  

 Enter a label or Nodal Spring ID in the LABEL text box and enter the corresponding Spring Constant.  

 Click on the ADD button to add the entry to the list box.  

 Repeat the two steps above for each Nodal Spring entry.  

 To edit an entry, select it from the list box, modify its value(s) in the text box(es), and click on the 

MODIFY button to register the changes.  

 To delete a Nodal Spring entry, select it from the list box and click on the DELETE button.  

To Define Slaved Nodes:  

Slaved nodes are nodes that share a particular degree of freedom (Dz, Rx or Ry). A slaved node group must 

first be defined and then the nodes to be included in the group are assigned using the Assign / Slaved Nodes 

command. A group is defined by giving it a label and a degree of freedom.  

 From the Define menu select Slaved Nodes, or if the RESTRAINTS folder is displayed, click on SLAVED 

NODES found in the ITEM LISTING AREA to have the program surface the SLAVED NODES input screen:  
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 Enter a label or Slaved Node ID in the LABEL text box.  

 From the Degree of Freedom option group, select the degree of freedom that the slaved nodes will share, 

displacement in the Z-direction (Dz), rotation about the x-axis (Rx), or rotation about the Y-axis (Ry).  

 Click on the ADD button to add the entry to the list box.  

 Repeat the three steps above for each slaved node group.  

 To edit an entry, select it from the list box, modify its value(s) in the text box(es), and click on the 

MODIFY button to register the changes.  

 To delete a slaved node group, select it from the list box and click on the DELETE button.  

To Define Piles:  

 Surface the RESTRAINTS folder and click on PILES found in the ITEM LISTING AREA to have the program 

surface the PILES input screen.  

 Enter a label or Pile ID in the LABEL text box 

and enter the corresponding Spring Constant.  

 Click on the ADD button to have the program 

surface the following dialog box:  

 Enter a Label for the pile and from the PILE 

TYPE drop-down list, select between ROUND, 

SQUARE, RECTANGULAR, and H-TYPE.  

 What you select in the PILE TYPE drop-down list 

dictates the fields that will be made available 

for the PILE DIMENSIONS. Use the image that 

will be displayed just underneath the PILE TYPE 

selection as a guide when filling out the Pile Dimensions.  

 If the pile is embedded in the slab, then enter the depth of embedment, otherwise leave zero in 

EMBEDMENT field. 

 Select the Pile Material by choosing CONCRETE, STEEL, or PRECAST from the respective drop-down list.  

 Use the SELECT SOIL drop-down list to select the soil. Recall that the soil and its corresponding 

properties are defined by you. (See To Define the Soil Properties, explained earlier.)  

 Click on the OK button to close the dialog box and to return focus to the Piles folder. Notice how the pile 

has been added as an entry to the list box.  

 Repeat the steps above for each Pile entry.  

 To edit an entry, select it from the list box, if you wish to modify it’s LABEL or SPRING CONSTANT, 

simply edit the values in the respective text boxes and click on the MODIFY button to register the 

changes. If you wish to edit the TYPE, DIMENSIONS, SOIL TYPE, or PILE MATERIAL, click on the EDIT 

button to surface the corresponding dialog box, modify the value(s) in the text box(es) and then g click 

on the OK button to close the dialog box and to return focus to the Piles folder.  
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 To delete a Pile entry, select it from the list box and click on the DELETE button. 

Defining Load Combinations  

Loads are applied to nodes and elements under 26 load cases (A through Z). The load cases are combined 

under load combinations and the analysis is performed for each load combination. The Program requires at 

least one Service and one Ultimate Load Combination to solve a model. The Load Combinations input screen 

has a worksheet format. It consists of cells that are organized into columns and rows. Data in each row 

correspond to one load combination. For clarity, only non-zero values are displayed in the worksheet, i.e., 

blank cells denote zero values. A load combination is identified by its label which has to be unique. Labels 

may also be assigned to load cases to describe the case and to indicate the type of loading associated with the 

case. Load case labels are provided to help the user identify load cases and they have no impact on analysis or 

design. The user may keep the default load case labels, remove them, or edit them as long as each (non-

empty) label is unique. 

 From the Define menu, choose Load Combinations to have the program surface the LOAD 

COMBINATIONS folder. 

Alternatively, you can click on the  button located on the toolbar, and then on the LOAD 

COMBINATIONS tab.  

 Select INCLUDE SELF WEIGHT IN CASE A CHECK BOX to enable self-weight calculations for load case A. 

To Define Service Load Combinations:  

 Surface the LOAD COMBINATIONS folder and click on the SERVICE item found in the ITEM LISTING AREA 

to have the program surface the SERVICE LOAD COMBINATIONS input screen. 

 Edit load case labels associated with load cases A through Z 

 Press INSERT button to add the first row into the worksheet. By default, the program labels the load 

combination as S1. Each Load Combination Label shall be unique. 

 Keep or rename Service Load Combinations Label. 

 Enter non-zero load factors for each load case (A through Z). 

 Repeat the three steps above for each service load combination entry. 
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To Define Ultimate Load Combinations: 

 Surface the LOAD COMBINATIONS FOLDER and click on the ULTIMATE item found in the ITEM LISTING 

AREA to have the program surface the ULTIMATE LOAD COMBINATIONS input screen: 

 

 Press INSERT button to add the first row into the worksheet. By default, the program labels the load 

combinations as U1. Each Load Combination Label shall be unique. 

 Keep or rename Ultimate Load Combination Label. 

 Enter non-zero load factors for each load case (A through Z) 

 Repeat the three steps above for each ultimate load combination entry. 

Pop-up Menu Commands 

The following commands are available when right-clicking anywhere within the worksheet or by using 

keyboard shortcuts. 

 

Insert (Ins) 

Inserts a new row below the selected row. New row is assigned a unique default load combination label 

which may be changed by the user. 
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Delete (Del) 

Deletes the selected row or rows if multiple rows are selected. 

Modify (F2 or Enter) 

Makes the current cell editable. 

Clear (Ctrl+Del) 

Resets the value in a cell to zero. 

Move up (Alt+Up) 

Moves the load combination data one row up. 

Move down (Alt+Down) 

Moves the load combination data one row down. 

Import… 

Imports load combinations from text file. 

Copy 

Copies to clipboard the contents of a selected cell or cells. 

Paste 

Pastes the contents of the clipboard into a cell or multiple cells within the worksheet. No new rows are 

inserted. The Paste function allows the copying of the load combination data from an Excel Spreadsheet 

into LOAD COMBINATIONS folder. 

To Import Load Combinations from Text File 

 Click the IMPORT… button or, alternatively, choose File / Import / Combinations… to have the 

program display the following OPEN dialog box: 

 

 All files with the TXT extension contained in the current drive and directory are displayed in the FILE 

NAME list box. 

 To open a file that exists in another drive or directory, select the drive or directory you want from the 

LOOK IN drop-down list. 

 From the FILE NAME list box, select the file to be opened, or simply type its name in the text box.  

 Choose the OPEN button. 

Note: Refer to Import File Formats section of the Appendix for description of the load combinations import 

file. 
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Defining Loads 

Nodal and element loads are defined using the Define / Loads command. They are then assigned to the nodes 

using the Assign / Nodal Loads command, and to elements using the Assign / Surface Loads command. 

Load input screens have a worksheet format. It consists of cells that are organized into columns and rows. 

Each row corresponds to one load entry. 

 From the Define menu, choose Loads to have the program surface the LOADS folder. 

Alternatively, you can click on the  button located on the toolbar, and then on the LOADS tab.  

To Define Concentrated Load(s):  

 Surface the LOADS folder and click on CONCENTRATED found in the ITEM LISTING AREA to have the 

program surface the CONCENTRATED LOADS input screen: 

 

 Press INSERT button to add the first row into the worksheet. By default, the program labels the load as P1, 

and the load case as A-DEAD. Each load label shall be unique. 

 Keep or rename a label or Concentrated Load ID in the LABEL column.  

 Keep the load case or select a load case (A through Z) from the drop-down list within the CASE column. 

Note that loads defined under a particular load case may be applied to the slab under that load case only. 

 Enter force (Pz), moment about the X-axis (Mx), and moment about the Y-axis (My) under Pz, Mx, and My 

respectfully. Note that downward forces (Pz) have negative values. To determine the direction of the 

moments Mx and My, use the right hand rule.  

 Repeat the four steps above for each concentrated load entry. 

To Define Surface Load(s):  

 Surface the LOADS folder and click on SURFACE found in the ITEM LISTING AREA to have the program 

surface the SURFACE LOADS input screen: 
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 Press INSERT button to add the first row into the worksheet. By, default, the program labels the load as 

W1, and the load case as A-DEAD. Each load label shall be unique.  

 Keep or rename a label or Surface Load ID in the LABEL column. 

 Keep the load case or select a load case (A through Z) from the drop-down list within the CASE column. 

Note that loads defined under a particular load case may be applied to the slab under that load case only.  

 Enter the load intensity Wz as a force per unit area under the Wz column. Note that downward forces (Wz) 

have negative values.  

 Repeat the four steps above for each surface load entry.  

Pop-up Menu Commands 

The following commands are available when right-clicking anywhere within the worksheet or by using 

keyboard shortcuts. 

Insert (Ins) 

Inserts a new row below the selected row. New row is by default assigned a unique load label and load 

case A-DEAD, both of  which may be changed by the user. 

Delete (Del) 

Deletes the selected row or rows if multiple rows are selected. 

Modify (F2 or Enter) 

Makes the current cell editable. 

Clear (Ctrl+Del) 

Resets the value in a cell to zero. 

Move up (Alt+Up) 

Moves the load combination data one row up. 

Move down (Alt+Down) 

Moves the load combination data one row down. 

Sort by Case 

Sorts all the load data rows alphabetically, starting from Case A. 

Import… 

Imports loads from text file. 

Copy 

Copies to clipboard the contents of a selected cell or cells. 

Paste 

Pastes the contents of the clipboard into a cell or multiple cells within the worksheet. No new rows are 

inserted. The Paste function allows the copying of the load data from an Excel Spreadsheet into LOADS 

folder. 
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To Import Loads from Text File 

 Click the IMPORT… button or, alternatively, choose File / Import / Loads… to have the program display 

the following Open dialog box: 

 

 All files with the TXT extension are contained in the current drive and directory are displayed in the FILE 

NAME list box. 

 To open a file that exists in another drive or directory, select the drive or directory you want from the 

LOOK IN drop-down list. 

 From the FILE NAME list box, select the file to be opened, or simply type its name in the text box.  

 Choose the OPEN button. 

Note: Refer to Import File Formats section of the Appendix for description of the load import file. 

Assigning Material Properties 

Once the grid, all components, material properties, design parameters, loads, and load combinations have 

been defined, you are ready to start assigning them - thereby putting the project together.  

 From the Assign menu, choose Thickness, Concrete, Soil, Reinforcing Steel, or Design Parameters to 

have the program surface the PROPERTIES folder as illustrated below: 
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Alternatively, you can click on the  button located on the toolbar, and then on the PROPERTIES 

tab.  

To Assign Element Thickness: 

 From the Assign menu, choose Thickness, or if the PROPERTIES folder is displayed, click on the  

symbol next to THICKNESS found in the ITEM LISTING AREA to expand the THICKNESS list. The 

thicknesses that will appear are those defined using the Define / Thickness command. See To Define The 

Element Thickness.  

 Select the thickness to be assigned. This becomes the active assignment. By default, the program will 

display all elements that share the active assignment in red and the inactive assignment in cyan. 

Unassigned grid space is by default displayed in white. Recall however that you may change the color 

preferences to your liking with the Options / Display command. 

 In the GRAPHICS AREA, using the left-mouse button, select a grid space or marquee select a group of grid 

spaces. The selected grid spaces are shown in red or in the color specified for ACTIVE OBJECTS in the 

DISPLAY folder. 

 To delete an element, remove its thickness assignment. To do so, repeat the step above using instead the 

right-mouse button.  

 Repeat the three steps above for each thickness entry.  

To Assign Soil Properties:  

 From the Assign menu select Soil, or if the PROPERTIES folder is displayed, click on the  symbol next 

to SOIL found in the ITEM LISTING AREA to expand the SOIL list. The soils that will appear are those 

defined using the Define / Soil command. See To Define The Soil Properties.  

 Select the soil to be assigned. This becomes the active assignment. By default, the program will display 

all elements that share the active assignment in red and the inactive assignment in cyan. Unassigned 

elements are by default displayed in powder blue. Recall however that you may change the color 

preferences to your liking with the Options / Display command. 

 In the GRAPHICS AREA, using the left-mouse button, select an element or marquee select a group of 

elements. The selected elements are shown in red or in the color specified for ACTIVE OBJECTS in the 

DISPLAY folder. 
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 To remove a soil assignment, repeat the step above using instead the right-mouse button.  

 Repeat the three steps above for each soil entry.  

To facilitate assignment of soil properties, options to show the element and node labels are provided in the 

pop-up menu accessible by right-clicking on any blank portion of the GRAPHICS/INPUT AREA. 

To Assign Concrete Properties:  

 From the Assign menu select Concrete, or if the PROPERTIES folder is displayed, click on the  symbol 

next to CONCRETE found in the ITEM LISTING AREA to expand the CONCRETE list. The concrete that will 

appear are those defined using the Define / Concrete command. See To Define The Concrete Properties.  

 Select the concrete to be assigned. This becomes the active assignment. By default, the program will 

display all elements that share the active assignment in red and the inactive assignment in cyan. 

Unassigned elements are by default displayed in powder blue. Recall however that you may change the 

color preferences to your liking with the Options / Display command. 

 In the GRAPHICS AREA, using the left-mouse button, select an element or marquee select a group of 

elements. The selected elements are shown in red or in the color specified for ACTIVE OBJECTS in the 

DISPLAY folder. 

 To remove a concrete assignment, repeat the step above using instead the right-mouse button.  

 Repeat the three steps above for each concrete entry.  

To facilitate assignment of material properties, options to show the element and node labels are provided in 

the pop-up menu accessible by right-clicking on any blank portion of the GRAPHICS/INPUT AREA. 

To Assign Reinforcing Steel Properties:  

 From the Assign menu select Reinforcing Steel, or if the PROPERTIES folder is displayed, click on the  

symbol next to REINFORCING STEEL found in the ITEM LISTING AREA to expand the REINFORCING STEEL 

list. The reinforcing steel entries that will appear are those defined using the Define/Reinforcing Steel 

command. See To Define The Reinforcing Steel Properties.  

 Select the reinforcing steel to be assigned. This becomes the active assignment. By default, the program 

will display all elements that share the active assignment in red and the inactive assignment in cyan. 

Unassigned elements are by default displayed in powder blue. Recall however that you may change the 

color preferences to your liking with the Options / Display command. 

 In the GRAPHICS AREA, using the left-mouse button, select an element or marquee select a group of 

elements. The selected elements are shown in red or in the color specified for ACTIVE OBJECTS in the 

DISPLAY folder. 

 To remove a reinforcing steel assignment, repeat the step above using instead the right-mouse button.  

 Repeat the three steps above for each reinforcing steel entry.  

To facilitate assignment of material properties, options to show the element and node labels are provided in 

the pop-up menu accessible by right-clicking on any blank portion of the GRAPHICS/INPUT AREA. 

To Assign Design Parameters:  

 From the Assign menu select Design Parameters, or if the PROPERTIES folder is displayed, click on the 

 symbol next to DESIGN PARAMETERS found in the ITEM LISTING AREA to expand the DESIGN 

PARAMETERS list. The design parameters that will appear are those defined using the Define / Design 

Parameters command. See To Define The Design Parameters.  

 Select the design parameter entry to be assigned. This becomes the active assignment. By default, the 

program will display all elements that share the active assignment in red and the inactive assignment in 
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cyan. Unassigned elements are by default displayed in powder blue. Recall however that you may change 

the color preferences to your liking with the Options / Display command. 

 In the GRAPHICS AREA, using the left-mouse button, select an element or marquee select a group of 

elements. The selected elements are shown in red or in the color specified for ACTIVE OBJECTS in the 

DISPLAY folder. 

 To remove a design parameter assignment, repeat the step above using instead the right-mouse button.  

 Repeat the three steps above for each design parameter entry.  

To facilitate assignment of design parameters, options to show the element and node labels are provided in 

the pop-up menu accessible by right-clicking on any blank portion of the GRAPHICS/INPUT AREA. 

To Assign Columns:  

 From the Assign menu select Column Dimensions, or if the PROPERTIES folder is displayed, click on the 

 symbol next to COLUMN DIMENSIONS found in the ITEM LISTING AREA to expand the COLUMN 

DIMENSIONS list.  

 Select the column entry to be assigned. This becomes the active assignment. By default, the program will 

display all nodes that share the active assignment in red and nodes with a different assignment in cyan. 

Recall however that you may change the color preferences to your liking with the Options / Display 

command. 

 In the GRAPHICS AREA, using the left-mouse button, select a node or marquee select a group of nodes. 

Columns are shown to scale at the selected nodes in red or in the color specified for ACTIVE OBJECTS in 

the DISPLAY folder. 

 To remove a column assignment, repeat the step above using instead the right-mouse button.  

 Repeat the three steps above for each column entry.  

 

To facilitate assignment of columns, options to show the element and node labels are provided in the pop-up 

menu accessible by right-clicking on any blank portion of the GRAPHICS/INPUT AREA. 

Assigning Restraints  

 From the Assign menu, choose Nodal Springs, Slaved Nodes or Restraints to have the program surface 

the RESTRAINTS folder as illustrated below. 
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Alternatively, you can click on the  button located on the toolbar, and then on the RESTRAINTS 

tab.  

Note: Applying both restraining and nodal slaving for the same degree of freedom at a node in not allowed. 

Use only restraining to achieve the same constraint conditions. Also, either a nodal spring or a pile, but not 

both, can be applied at a node. 

 

To Assign Nodal Restraints:  

Fixed nodes or supports are assigned using the Assign / Restraints command.  

 From the Assign menu, select Restraints, or if the RESTRAINTS is displayed, click on the  symbol next 

to RESTRAINTS found in the ITEM LISTING AREA to expand the RESTRAINTS list. You will be able to 

restrain Dz, Rx and Ry degrees of freedom.  

 Select the nodal restraint to be assigned. This becomes the active assignment. By default, the program 

will display all nodes that share the active assignment in red and nodes with a different assignment in 

cyan. Recall however that you may change the color preferences to your liking with the Options / 

Display command. 

 In the GRAPHICS AREA, using the left-mouse button, select a node or marquee select a group of nodes. 

The selected nodes are shown in red or in the color specified for ACTIVE OBJECTS in the DISPLAY folder. 

 To remove a nodal restraint assignment, repeat the step above using instead the right-mouse button.  

 Repeat the three steps above for each degree of freedom.  

To facilitate assignment of nodal restraints, options to show the element and node labels are provided in the 

pop-up menu accessible by right-clicking on any blank portion of the GRAPHICS/INPUT AREA. 

To Assign Nodal Springs:  

 From the Assign menu select Nodal Springs, or if the RESTRAINTS folder is displayed, click on the  

symbol next to NODAL SPRINGS found in the ITEM LISTING AREA to expand the NODAL SPRINGS list. The 

nodal springs that appear are those defined using the Define/Nodal Springs command. See To Define 

The Nodal Springs.  

 Select the nodal spring to be assigned. This becomes the active assignment. By default, the program will 

display all nodes that share the active assignment in red and nodes with a different assignment in cyan. 
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Recall however that you may change the color preferences to your liking with the Options / Display 

command. See To Change The Font and Color Preferences.  

 In the GRAPHICS AREA, using the left-mouse button, select a node or marquee select a group of nodes. 

The selected nodes are shown in red or in the color specified for ACTIVE OBJECTS in the DISPLAY folder.   

 To remove a nodal spring assignment, repeat the step above using instead the right-mouse button.  

 Repeat the three steps above for each nodal spring entry.  

To facilitate assignment of nodal springs, options to show the element and node labels are provided in the 

pop-up menu accessible by right-clicking on any blank portion of the GRAPHICS/INPUT AREA. 

To Assign Slaved Nodes:  

 From the Assign menu select Slaved Nodes, or if the RESTRAINTS folder is displayed, click on the  

symbol next to SLAVED NODES found in the ITEM LISTING AREA to expand the SLAVED NODES list. The 

slaved node entries that appear are those defined using the Define / Slaved Nodes command. See To 

Define the Slaved Nodes.  

 Select the slaved node to be assigned. This becomes the active assignment. By default, the program will 

display all nodes that share the active assignment in red and nodes with a different assignment in cyan. 

Recall however that you may change the color preferences to your liking with the Options / Display 

command. See To Change The Font and Color Preferences.  

 In the GRAPHICS area, using the left-mouse button, select a node or marquee select a group of nodes. The 

selected nodes are shown in red or in the color specified for ACTIVE OBJECTS in the DISPLAY folder.   

 To remove a slaved node assignment, repeat the step above using instead the right-mouse button.  

 Repeat the three steps above for each slaved node entry.  

To facilitate assignment of slaved nodes, options to show the element and node labels are provided in the 

pop-up menu accessible by right-clicking on any blank portion of the GRAPHICS/INPUT AREA. 

To Assign Piles:  

 From the Assign menu select Piles, or if the RESTRAINTS folder is displayed, click on the  symbol next 

to PILES found in the ITEM LISTING AREA to expand the PILES list. The piles that appear are those 

previously defined by you. See To Define the Piles.  

 Select the pile to be assigned. This becomes the active assignment. By default, the program will display 

all nodes that share the active assignment in red and nodes with a different assignment in cyan. Recall 

however that you may change the color preferences to your liking with the Options / Display command. 

See To Change The Font and Color Preferences.  

 In the GRAPHICS AREA, using the left-mouse button, select a node or marquee select a group of nodes. 

Piles are shown to scale at the selected nodes in red or in the color specified for ACTIVE OBJECTS in the 

DISPLAY folder.   

 To remove a pile assignment, repeat the step above using instead the right-mouse button.  

 Repeat the three steps above for each pile in the ITEM LISTING AREA.  

To facilitate assignment of piles, options to show the element and node labels are provided in the pop-up 

menu accessible by right-clicking on any blank portion of the GRAPHICS/INPUT AREA. 
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Applying Loads 

Once the grid, all components, material properties, design parameters, loads, and load combinations have 

been defined, you are ready to start assigning them - thereby putting the project together. To have the loads 

annotated during this assignment phase, right-click on a blank portion of the screen to find load annotation 

options within the pop-up menu. This menu also has the options to show element and node labels similar to 

the other assignment screens. 

 From the Assign menu, choose Surface Loads or Nodal Loads to have the program surface the LOADS 

folder as illustrated below: 

 

Alternatively, you can click on the  button located on the toolbar, and then on the LOADS tab. If 

columns or piles have been assigned to the model, they are displayed in the color specified for COLUMN 

or PILES in the DISPLAY SETTINGS. If it is preferred not to show columns or piles, right-click on empty 

space on the view window, and then uncheck Show Columns or Show Piles on the pop-up menu. 
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To Apply Surface Loads:  

The surface loads defined using the Define / Loads command may be applied to the mat elements using the 

Assign / Surface Loads command. The loads defined under the Dead, Live, and Lateral cases are applied 

under these cases as well.  

 From the Assign menu select Surface Loads, or if the LOADS folder is displayed, click on the  symbol 

next to the load CASE (A through Z) found in the ITEM LISTING AREA to expand the list. The two load 

types will appear, CONCENTRATED and SURFACE. Expand the Surface load types by clicking on the  

symbol next to SURFACE…  

 Select the load to be assigned. This becomes the active assignment. By default, the program will display 

all elements that share the active assignment in red and elements with a different assignment in cyan. 

Unassigned elements are by default displayed in powder blue. Recall however that you may change the 

color preferences to your liking with the Options / Display command. See To Change The Font and 

Color Preferences.  

 In the GRAPHICS AREA, using the left-mouse button, select an element or marquee select a group of 

elements. The selected elements are shown in red or in the color specified for ACTIVE OBJECTS in the 

DISPLAY folder.   

 To remove a surface load assignment, repeat the step above using instead the right-mouse button.  

 Repeat the three steps above for each load case.  

To Apply Concentrated (Nodal) Loads:  

 The concentrated loads defined using the Define / Loads command may be applied to the mat elements 

using the Assign / Concentrated Loads command. The loads defined under the Dead, Live, and Lateral 

cases are applied under these cases as well.  

 From the Assign menu select Nodal Loads, or if the LOADS folder is displayed, click on the  symbol 

next to the load CASE (A through Z) found in the ITEM LISTING AREA to expand the list. The two load 

types will appear, CONCENTRATED and SURFACE. Expand the Concentrated load types by clicking on the 

 symbol next to CONCENTRATED…  

 Select the load to be assigned. This becomes the active assignment. By default, the program will display 

all nodes that share the active assignment in red and nodes with a different assignment in cyan. Recall 

however that you may change the color preferences to your liking with the Options / Display command. 

See To Change The Font and Color Preferences.  

 In the GRAPHICS AREA, using the left-mouse button, select a node or marquee select a group of nodes. 

The selected nodes are shown in red or in the color specified for ACTIVE OBJECTS in the FONT & 

COLOR folder. 

 To remove a nodal load assignment, repeat the step above using instead the right-mouse button.  

 Repeat the three steps above for each load case.  

Solving the Model 

After inputting the model, the solver portion of the program is executed using the Solve / Execute command.  

 From the Solve menu, choose Execute to have the program surface the SOLVER folder.  

Alternatively, you can click on the  button located on the toolbar, and then on the RUN 

SOLVER tab.  
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 MAXIMUM NUMBER OF ITERATIONS:  

If uplift is detected during the 

solution, the soil, nodal spring, and 

pile contributions at the uplift nodes 

are eliminated and the problem is 

resolved. This procedure is repeated 

until no further uplift is encountered 

or until the set maximum number of 

iterations is reached, whichever 

comes first.  

 MAXIMUM ALLOWED SERVICE 

DISPLACEMENT:  

The displacement value (positive or 

negative) at each node under service 

load combinations is checked against 

this value. If it is exceeded at any 

service load combination, the 

solution will not be completed and an error message will 

appear during the solution. No results and contour views 

will be generated. The Program will surface Solve / View 

Results / Solve Messages window which will display a 

“Maximum Allowed Service Displacement Exceeded” 

message for the first service load combination that did not 

meet the criteria.  

 MINIMUM RATIO OF SOIL CONTACT AREA W.R.T. TOTAL INITIAL SOIL-SUPPORTED AREA (%)  

If uplift is detected during the solution, the tributary area Asoil, of all soil-supported nodes in uplift is 

computed. The program also computes the sum of the tributary area, At, of all non-restrained nodes. The 

ratio of soil contact area is defined as (Asoil - Au, soil)/Asoil. If during the solution, this ratio falls below the 

specified minimum ratio of soil contact area for any load 

combinations, the solution will not be completed and an 

error message will appear during the solution. The 

program will surface Solve / View Results / Solve 

Messages window which will display a “solution 

Errors” message for the first load combination that did 

not meet the criteria. 

 MINIMUM RATIO OF ACTIVE SPRINGS/PILES W.R.T. TOTAL NUMBER OF SPRING/PILES AREA (%) 

If uplift is detected during the solution, the number of springs/piles in uplift NS/P, uplift is computed. The 

program also computes the total number of springs/piles NS/P, total. The ratio of active springs/piles is 

defined as [NS/P, total - NS/P, uplift] / NS/P, total. During the solution, if this ratio falls below the minimum 

ratio of active springs/piles for any load combination, the 

solution will not be completed and an error message will 

appear during the solution. No results and contour views 

will be generated. The program will surface Solve / View 

Results / Solve Messages window which will display a 

“Solution Errors” message for the first load combination 

that did not meet the criteria. 

 MAT UPLIFT OCCURS FOR POSITIVE NODAL DISPLACEMENT EXCEEDING: 

This is the value of displacement beyond which a node is considered to be in uplift. 

 COMPUTE REQUIRED REINFORCEMENT BASED ON: 
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For each element, each of the design moments (Mux and Muy, top and bottom) is computed for 

a governing ultimate load combination. The governing load combination is the one that produces the 

maximum design moment Mux and Muy respectively in the X- and Y-directions, and separately for top and 

bottom reinforcement. The required area of reinforcement for an element may be computed based on:  

 MAXIMUM MOMENT WITHIN AN ELEMENT (the maximum moment at any of the four element nodes.)  

 AVERAGE MOMENT WITHIN AN ELEMENT (the average moment value at all element nodes.)  

 The input is first verified for any inconsistencies or errors. If there is data missing or still required, a 

message box will be displayed.  

 The program then switches control to the 

solver module. A message box reporting the 

progress and status of the solution is 

displayed.  

 When the solution is successfully 

completed, a contour map showing 

downward displacement envelope is 

displayed. If the solution procedure fails, a 

message box appears. Detailed information 

on the solution may be found in the Solve / 

View Results / Solve Messages window.  

 After a successful run, results may be 

viewed using the Solve / View Results 

command. The results can be printed using 

the File / Print Results command. Results 

may also be plotted using the Solve / View 

Contours command.  

Viewing Results 

After a successful run, the output may be viewed using the Solve / View Results command.  

 From the Solve menu, choose View Results to have the program surface the VIEW RESULTS folder as 

illustrated below. 

Alternatively, you can click on the  button located on the toolbar, and then on the VIEW 

RESULTS tab.  

Results may be selected by holding the Ctrl or Shift key and clicking on the lines in the main window. 

Press the PRINT button to print the selected lines, or press the COPY button to copy the selected lines to 

clipboard. If no lines are selected, all the currently displayed results in the main window will be printed 

or copied. 

 The results are categorized into three types: 

 Envelope 

 Service 

 Ultimate 

 Expand the type you wish to view by clicking on the  symbol next to the type (ENVELOPE, SERVICE, or 

ULTIMATE) found in the ITEM LISTING AREA.  

 If Service or Ultimate is selected, a combination must be selected from the expandable list. For more 

information on the output tables, see Program Results in Chapter 2.  

 Choose the result table to display from the available items in the right ITEM LISTING AREA.  
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 The requested information is shown in the GRAPHICS / INPUT AREA. Use the scroll bars to navigate 

through the results. To print the displayed results, choose the File / Print Results command.  

 

Viewing Contours 

After a successful run, the output may be graphically viewed using the Solve / View Contours command. 

 From the Solve menu, choose View Contours to have the program surface button located on the toolbar,  

Alternatively, you can click on the  button located on the toolbar, and then on the VIEW 

CONTOURS tab.  

 The results are categorized into three types: 

 Envelope 

 Service 

 Ultimate 

 Once the VIEW CONTOURS folder surfaces, expand the type you wish to view by clicking on the  

symbol next to the type (ENVELOPE, SERVICE, or ULTIMATE) found in the ITEM LISTING AREA.  

 Locate the results you wish to view graphically by expanding to the root.  

 The requested contours are shown in the GRAPHICS/INPUT AREA. Note that top and bottom moments are 

plotted separately.  

 To print the displayed contours, choose the File / Print Screen command. 
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If columns have been assigned to the model, they are displayed to scale in black color. If piles have been 

assigned to the model, they are displayed to scale in dark red color. To not show columns or piles, right-click 

on empty space on the view window, and then uncheck Show Columns or Show Piles on the pop-up menu. 

When flexure design of some elements fails, a message box will appear during the solution indicating that 

steel design of some elements failed. However, the solution will complete and results and contour views will 

be generated. When the user wants to display a contour map with plate flexural reinforcement, the program 

will display a warning message indicating that steel design results are incomplete and then the contour map 

will be shown. Failed locations are marked with the color assigned to plate element in Options / Display 

Preferences and a diagonal pattern as illustrated here: 

 

When calculating soil pressures, if some elements exceed the allowable soil pressure, a message box will 

appear during the solution indicating that allowable soil pressure has been exceeded. However, the solution 

will complete and results and contour views will be generated. When the user wants to display a contour map 

with service-level pressures, the program will display the warning message indicating that elements where 

allowable soil pressure is exceeded are marked with diagonal pattern and then the contour map will be shown. 



 

4-34  Operating spMats 

Failed locations are marked with the color assigned to plate element in Options / Display Preferences and 

a diagonal pattern as illustrated here: 

 

 

 

When concrete punching shear capacity is exceeded, a message box will appear during the solution indicating 

that concrete punching shear capacity exceeded. However, the solution will complete and results and contour 

views will be generated. When the user wants to display ultimate-level punching shear results, the report will 

display the status of the failed column and/or pile as unsafe, shown here: 
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Accessing 3D View  

The 3D view provides a three dimensional graphic representation of the slab. This screen allows you to rotate 

the slab, zoom in, zoom out and pan.  

 From the View menu, choose 3D to have the program surface the 3D VIEW folder. 

Alternatively, you can click on the  button located on the toolbar, and then on the 3D VIEW tab.  
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Using the Zoom Command: 

The Zoom command is used to enlarge or reduce the image shown in the 3D VIEW folder in the GRAPHICS / 

INPUT AREA. This command is only used for display purposes and does not affect the model geometry.  

To Zoom In: 

 With the 3D VIEW folder displayed, click on the  button found at the bottom of the GRAPHICS / 

INPUT AREA.  

Using the left-mouse button, marquee select the portion of the graphical image you wish to enlarge. The 

selected area is enlarged to occupy the entire GRAPHICS / INPUT area.  

To Zoom Out: 

 With the 3D VIEW displayed, click on the  button found at the bottom of the GRAPHICS / INPUT 

AREA.  

 Using the left-mouse button, marquee select the portion of the graphical image you wish to reduce. The 

selected area is proportionally readjusted in the GRAPHICS / INPUT area.  

Using the Pan Command:  

The Pan command is used to move the image shown in the 3D VIEW folder in the GRAPHICS / INPUT area. 

Image panning or translation is a linear movement of the viewport. This command is only used for display 

purposes and does not affect the model geometry.  

 With the 3D VIEW folder displayed, click on the  button found at the bottom of the GRAPHICS / 

INPUT area.  

 Click and hold the left-mouse button on the graphic while dragging it around the GRAPHICS / INPUT area. 

The image is anchored (moved) when the left-mouse button is released.  

Using the Reset Command:  

The Reset command is used to reset the image shown in the 3D VIEW folder in the GRAPHICS / INPUT AREA to 

its default position.  

 With the 3D VIEW folder displayed, click on the  button found at the bottom of the GRAPHICS / 

INPUT area.  

Alternatively, you can simply right-mouse click anywhere within the GRAPHICS / INPUT area.  



 

Operating spMats  4-37 

Using the Rotate Command:  

The Rotate command is used (in isometric 3D only) to rotate the image shown in the 3D 

VIEW folder so that the model may be viewed from a different viewpoint. This command 

works with the axis-orientation box located at the bottom of the GRAPHICS / INPUT area… 

This command is only used for display purposes and does not affect the model geometry.  

 With the 3D VIEW folder displayed, click and hold down the left mouse button on the 

axis-orientation box.  

 Drag the mouse in any direction while holding down the left-mouse button. Notice the corresponding 

rotations of both the axis bar as well as the graphic. The axis orientation represents the position of the 

model as soon as the left-mouse button is released.  

Defining Options 

There are many options that can be set as default so that they are saved in memory to be applied to any 

subsequent project until they are changed again.  

 From the Options menu, choose Startup Defaults, Autosave, Display or Statistics to have the program 

surface the respective OPTION folder as illustrated. 

Alternatively, you can click on the  button located on the toolbar.  

To Define Startup Defaults:  

The Options / Startup Defaults command is used to save the current file settings to be used in future input 

sessions. Default settings are saved in the Windows registry file. Settings that are saved include units of 

measure, code, and default directories.  

 With the STARTUP folder surfaced, from the UNITS options group, choose the applicable units of measure 

and from the CODE options group, select the appropriate design code. 

 Select the DEFAULT DEFINITIONS / LOAD FROM TEMPLATES option which provides default definitions and 

load combinations in the define window to facilitate creation of new models. The values of the 

parameters will depend on the code and the unit system selected in the STARTUP DEFAULTS window. If 

the option is enabled, then the newly created data file will by default contain predefined values stored in 

template files located in the Templates subfolder of the spMats program folder (e.g., "c:\Program 

Files\StructurePoint\spMats\Templates"). The user may open the template files and modify them as 

regular spMats files in order to customize the default values to the user’s needs. 
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 Check the ASSIGN DEFAULT PROPERTIES if – at the time of assigning thickness to an element in the 

model – you want the program to automatically assign properties from remaining and unassigned 

categories based on one of the three following options: 

 ASSIGN ONLY IF ONE PROPERTY DEFINED will assign other properties to the element of defined 

thickness if they are the only definitions within their property category. 

 ASSIGN ALWAYS FIRST DEFINED PROPERTY will assign the first properties from each category to the 

element of defined thickness. 

 ASSIGN MATCHING PROPERTIES will assign properties whose positions within their respective 

categories are the same as the position of the thickness being assigned. 

Once the automatic assignment has been made the user can manually reassign the properties. 

 Specify a default data directory. The path you specify here is where any data files you save will be saved 

by default. Note, however, that you will still be able to specify a different location when you attempt to 

save. See Saving the Data.  

 You may also control the number of lines printed per page.  

To Control the Autosave Feature:  

The Options / Autosave command is used to force the program to save your input data to disk at predefined 

intervals. This minimizes loss of data in case of a power loss or computer lock-up. Note that the file must be 

named (using the File / Save As command) prior to activating this feature.  

 With the AUTOSAVE folder surfaced, place a checkmark 

in the ENABLE AUTOSAVE box to activate the autosave 

feature.  

 In the Frequency text box, specify the time interval that 

you would like the program to run the autosave feature.  

To Customize Display Settings:  

The Display command is used to change various display settings such as font, object colors, 3D View 

options, and 2D View options. 

 Within the FONT group, click on the CHOOSE FONT button to select the font type and size that will be 

used in plotting the node and element numbers on the graphical display. The font types that appear in the 

list are those saved in your WINDOWS/FONTS directory. The font you specify here is also used in screen-

printing. 

 Use the color drop-down lists within the OBJECT COLORS group to select preferred colors for the 

following: 

 Grid 

 Active object 

 Inactive object 

 Frame  

 Background 

 Column 

 Pile 

 Nodal Load 

 Surface Load 
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 Click the DEFAULT COLORS button to change colors back to their default settings. 

 Settings within the 3D VIEW OPTIONS group control the 3D display of the model. The user can modify 

the following: 

 VERTICAL SCALE – To change scaling along the Z–axis (vertical) of the model 

 ANGLE XY – To change the angle at which the model is viewed with respect to the Z (vertical axis) 

of the screen 

 ANGLE YZ – To change the angle at which the model is viewed with respect to the X (horizontal 

axis) of the screen 

 Settings within the 2D VIEW OPTIONS group control the display of the model in 2D view windows such 

as GRID, ASSIGN, and CONTOUR windows. The user can modify the following: 

 SHOW NODE LABELS AS: Numbers or coordinates 

 SHOW NODE LABELS FOR: Nodes with assigned loads, piles, restraints, columns or all nodes 

 SHOW ELEMENT NUMBERS – Toggles the display of element numbers 

 SHOW COLUMNS – Toggles the display of column locations, column sections are displayed to scale 

 SHOW PILES – Toggles the display of pile locations, pile sections are displayed to scale 

 GRID LINE TYPE – Selects the style of the grid line, SOLID or DOTTED 

 COORDINATE PRECISION – Specifies the precision of the cursor location displayed in the STATUS 

BAR 

To View Project Statistics:  

 Surface the STATISTICS folder by using the Options / Statistics command.  

Alternatively, you can click on the  button located on the toolbar, and then on the STATISTICS 

tab. 

 The folder displays a statistical summary on the number of nodes, elements, and definitions.  
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Chapter 5 – Examples 

Examples 

Example 1 

Problem Formulation 

The 10' x 10' x 2' footing is presented in Joseph F. Bowles’ Foundation Analysis and Design, Fourth Edition, 

1988, p.461. 

A 500-kip load is applied at the center of the footing.  

Use the following data: 

Concrete:  '

cf = 3.0 ksi, 

 wc = 148 pcf, 

 Ec =3,245ksi, 

 v = 0.15, 

Soil: subgrade modulus = 100 kcf, 

 allowable pressure = 6 ksf, 

Steel: fy = 60 ksi, 

 Es = 29,000 ksi. 

The origin of the XY plane will be located at the lower left-hand corner of the footing. Two-foot square 

elements will be used; thus, the grid system consists of six grid lines (i.e. five elements), two feet apart, in 

each direction. The concentrated load will be applied as four nodal loads (125 kip each). The finite element 

mesh is shown at the end of this example.  

Preparing Input36 

1. From the Define menu, select General Info to surface the DESCRIPTION folder. 

 Input the project information and select ENGLISH units along with the ACI 318-14 code. 

                                                           

36 All input data entered manually assuming that Load From Template option is not selected in Startup Defaults 

24” x 24”
column
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2. From the Define menu, select Grid, or simply click on the  tab to surface the respective folder.  

 

Since the grid layout is uniform, and symmetrical in both directions, X- and Y-grid lines will be 

generated.  

 Double-click on the GENERATE option in the ITEM LISTING AREA to have the program surface the 

following:  

 

 Place a check mark in the X DIRECTION box and enter the following values in the corresponding text 

boxes:  

FROM DISTANCE:   0 
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NUMBER OF GRIDS:   6 

GRID SPACING:    2 

 Repeat the above step for the Y-DIRECTION.  

 Click on the GENERATE button to return focus to the GRID folder. Notice how the X- and Y-grid lines 

now appear in the GRAPHICS/INPUT AREA.  

3. From the Define menu, choose Thickness to surface the PROPERTIES folder shown here: 

 

 Input Thick1 for LABEL and 24.0 for THICKNESS.  

 Click on the ADD button to add the entry to the list.  

4. From the Define menu, choose Soil.  

 Enter the following: 

LABEL:    Soil1 

SUBGRADE MODULUS:  100 kcf 

ALLOWABLE PRESSURE:   6 ksf 

 Click on the ADD button to add the entry to the list.  

5. From the Define menu, choose Concrete or click on the CONCRETE option in the ITEM LISTING AREA to 

have the program surface the respective folder.  

 Enter the following: 

LABEL:     Conc1 

COMPRESSIVE STRENGTH:   3 ksi 

UNIT WEIGHT:   148 pcf 

YOUNG’S MODULUS:  3245 ksi 

POISSON’S RATIO:   0.15 

 Click on the ADD button to add the entry to the list.  

6. From the Define menu, choose Reinforcing Steel or click on the REINFORCEMENT option in the ITEM 

LISTING AREA to have the program surface the respective folder.  

 Enter the following: 

LABEL:    Steel1 

YIELD STRENGTH:    60 ksi 

YOUNG’S MODULUS:  29000 ksi 

 Click on the ADD button to add the entry to the list.  

7. From the Define menu, choose Design Parameters or click on the DESIGN PARAMETERS option in the 

ITEM LISTING AREA to have the program surface the respective folder.  

 Enter the following: 

LABEL:    DC1 
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MIN. REINF. RATIO:   0.09 % 

X-DIR  (TOP LAYER):   3.25 in 

(BOTTOM LAYER): 3.25 in 

Y-DIR  (TOP LAYER):   3.75 in 

(BOTTOM LAYER):  3.75 in 

 Click on the ADD button to add the entry to the list. 

 

8. From the Define menu, choose Load Combinations, or simply click on the  tab to surface 

the respective folder.  

 Select SERVICE FROM ITEM LISTING AREA. 

 Click on the INSERT button. 

 Enter S1 for LABEL.  

 Enter 1.0 for CASE A. 

 Select ULTIMATE FROM ITEM LISTING AREA. 

 Click on the INSERT button. 

 Enter U1 for LABEL. 

 Enter 1.0 for CASE A.  

 Uncheck the Include SELF WEIGHT IN CASE A for all combinations box.  

9. From the Define menu, select Loads, or simply click on the  tab to surface the respective 

folder. 

 

 Select CONCENTRATED from the ITEM LISTING AREA and click on the INSERT button. 

 Enter P1 for LABEL.  

 Enter A for the LOAD CASE and enter –125 for Pz.  

Assigning Properties  

10. From the Assign menu, select Thickness to surface the respective folder.  

 From the ITEM LISTING AREA, select THICK1.  
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 In the GRAPHICS/INPUT AREA, marquee select the region (-1, 11)-(11, -1) to apply the selected 

thickness to the entire footing. The selected elements are redrawn in red.  

Note: To see the assigned element and node numbers, from the Define menu, select Grid, and once 

the GRID folder surfaces, double click on PREFERENCES in the ITEM LISTING AREA. 

11. From the Assign menu, select Soil or click on the SOIL option in the ITEM LISTING AREA.  

 Expand the SOIL listing in the ITEM LISTING AREA and select SOIL1.  

 In the GRAPHICS/INPUT AREA, marquee select the region (-1, 11)-(11, -1) to apply the selected soil to 

the entire footing. The selected elements are redrawn in red.  

12. Repeat the step above using the Assign / Concrete, Assign / Reinforcing Steel and Assign / Design 

Parameters commands to apply CONCRETE1, STEEL1 and DC1 properties to the entire footing.  

13. From the Assign menu, select Nodal Loads or simply click on the  tab to surface the respective 

folder. 

 In the ITEM LISTING AREA, expand Case A and then expand Concentrated to select P1.  

 In the GRAPHICS AREA, click on each of the four nodes (4, 4), (6, 4), (4, 6), and (6, 6). Small red 

squares are shown indicating loaded nodes: 

 

Solving  

14. From the Solve menu, select Execute to surface the SOLVER folder. 
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 Enter 10, 11, 50, 0, and 0 in the text boxes and choose the MAXIMUM MOMENT WITHIN AN ELEMENT 

option.  

 Click on the RUN button.  

 The spMats Solver window is displayed and the solver messages are listed. After the solution is done 

focus will immediately be passed to the View Results folder.  

Viewing and Printing Results  

15. To view the results in text format, use the Solve / View Results command. Selective printing may be 

done from the displayed box or using the File / Print Results command.  

16. To view the results in graphical format, use the Solve / View Contours command. A printout of the 

screen may be obtained using the File / Print Screen command. 

 

Sample Results for Example 1 

 

Displacement contours for Example 1 
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Element and Node Numbering for Example 1 
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Example 2 

Problem Formulation 

Analyze the mat shown below. For instructional purposes, the default definitions and grid dimensions will be 

ignored. 

 

 

The mat is supported on two types of soil, Soil-1 and Soil-2, as shown in the figure. Use the following data: 

Concrete:  '

cf = 3.0 ksi, 

 wc = 145 pcf, 

 Ec =3,156ksi, 

 v = 0.15, 

Soil-1: subgrade modulus = 50 kcf, 

 allowable pressure = 6 ksf, 

Soil-2: subgrade modulus = 75 kcf, 

 allowable pressure = 8 ksf, 

Steel: fy = 60 ksi, 

 Es = 29,000 ksi. 
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The superstructure was analyzed for wind loads. The resulting reactions for the columns and wall, as well as 

for the dead and live loads, are as follows: 

  Dead Live Wind 

Column Pz (kip) -50 -35 -10 

 Mx (ft-kip) 0 0 5 

 My(ft-kip) 0 0 0 

Wall Pz (kip) -376 -208 -80 

 Mx (ft-kip) 0 0 60 

 My (ft-kip) 0 0 0 

The mat will be analyzed for three service combinations and three ultimate combinations. Deflections and 

pressures are to be checked for the service combinations and the mat will be designed (compute required 

reinforcement) for the ultimate combinations.  

Service Combinations: S1 = D+L 

  S2 = D + L + W 

  S3 = D + W 

Ultimate Combinations: U1 = 1.4 D 

    U2 = 1.2 D + 1.6 L 

    U3 = 1.2 D + 1.0 L 

    U4 = 1.2 D + 0.8 W 

    U5 = 1.2 D + 1.0 L + 1.6 W 

    U6 = 0.9 D + 1.6 W 

    U7 = 1.2 D - 0.8 W 

    U8 = 1.2 D + 1.0 L - 1.6 W 

    U9 = 0.9 D - 1.6 W 

The lower left-hand corner of the mat is chosen as the origin of the grid system. The grid layout is shown at 

the end of this example.  

Since the wall is spanning over five nodes (nodes 205, 229, 253, 277 and 291), the wall loads will be divided 

into equivalent nodal loads depending on the tributary length of each node. Furthermore, the Rx degrees of 

freedom of these five nodes are slaved to simulate the stiffening effect of the wall.  

Wall Loading Conditions 
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Preparing Input37  

1. From the Define menu, select General Info to surface the DESCRIPTION folder. 

 

 Input the project information and select ENGLISH units along with the ACI 318-14 code. 

2. From the Define menu, select Grid, or simply click on the tab to surface the respective folder. 

The X-Grid will be created in three parts as per the illustration here: 

 

                                                           

37 All input data entered manually assuming that Load From Template option is not selected in Startup Defaults. 
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 Double-click on the GENERATE option in the ITEM LISTING AREA to have the program surface the 

GENERATE dialog box.  

 Place a check mark in the X-Direction box and enter the following values in the corresponding text 

boxes:  

FROM DISTANCE:   0 

NUMBER OF GRIDS:   12 

GRID SPACING:   2 

 Place a check mark in the Y-Direction box and enter the following values in the corresponding text 

boxes:  

FROM DISTANCE:   0 

NUMBER OF GRIDS:   20 

GRID SPACING:   2 

 Click on the GENERATE button to return focus to the GRID 

folder. Notice how the X- and Y-grid lines now appear in the 

GRAPHICS/INPUT AREA. Note that you have just generated the 

Y-Grid lines for the entire slab and the X-grid lines have only 

been generated for section 1 as per the illustration above.  

 To create the two grid lines in section 2, double-click on the 

SET UP option in the ITEM LISTING AREA to have the program 

surface the following dialog box: 

  With the X-DIRECTION option chosen, input 25 in the 

COORDINATE text box and click on ADD.  

 Input 28 in the COORDINATE text box and click on ADD.  

 Click on OK to return focus to the GRID folder. Note how the two grid lines just added now appear in 

the GRAPHICS/INPUT AREA.  

  To create the remaining grid lines in the third section, 

double-click on the GENERATE option in the Item 

Listing Area to have the program surface the 

GENERATE dialog box, shown here for illustrative 

purposes:  

 Place a check mark in the X-DIRECTION box and enter 

the following values in the corresponding text boxes:  

FROM DISTANCE:   30  

NUMBER OF GRIDS:   10  

GRID SPACING:   2  

 Click on the GENERATE button to return focus to the GRID folder. Notice how the 10 new X-grid 

lines now appear in the GRAPHICS/INPUT AREA.  

3. From the Define menu, choose Thickness to surface the PROPERTIES folder.  
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 Input Thick1 for LABEL and 24.0 for THICKNESS.  

 Click on the ADD button to add the entry to the list.  

 Input Thick2 for LABEL and 36.0 for THICKNESS.  

 Click on the ADD button to add the entry to the list.  

4. From the Define menu, choose Soil, or click on the SOIL option in the ITEM LISTING AREA to have the 

program surface the respective folder.  

 Enter the following: 

LABEL:     Soil1 

SUBGRADE MODULUS:  50 kcf 

ALLOWABLE PRESSURE:  6 ksf 

 Click on the ADD button to add the entry to the list.  

 Enter the following: 

LABEL:    Soil2 

SUBGRADE MODULUS:  75 kcf 

ALLOWABLE PRESSURE:  8 ksf 

 Click on the ADD button to add the entry to the list.  

5. From the Define menu, choose Concrete or click on the CONCRETE option in the ITEM LISTING AREA to 

have the program surface the respective folder. 

 Enter the following: 

 LABEL:     Conc1 

COMPRESSIVE STRENGTH:  3 ksi 

UNIT WEIGHT:    145 pcf 

YOUNG’S MODULUS:  3156 ksi 

POISSON’S RATIO:   0.15 

 Click on the ADD button to add the entry to the list.  
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6. From the Define menu, choose Reinforcing Steel or click on the REINFORCEMENT option in the ITEM 

LISTING AREA to have the program surface the respective folder.  

 Enter the following: 

LABEL:    Steel1 

YIELD STRENGTH:   60 ksi 

YOUNG’S MODULUS:  29000 ksi 

 Click on the ADD button to add the entry to the list.  

7. From the Define menu, choose Design Parameters or click on the DESIGN PARAMETERS option in the 

ITEM LISTING AREA to have the program surface the respective folder.  

 Enter the following: 

LABEL:    DC1 

MIN. REINF. RATIO:   0.09 % 

X-DIR  (TOP LAYER):  3.25 in 

  (BOTTOM LAYER): 3.25 in 

Y-DIR  (TOP LAYER):  3.50 in 

 (BOTTOM LAYER): 3.50 in 

 Click on the ADD button to add the entry to the list.  

8. From the Define menu, choose Column Dimensions or click on the COLUMN DIMENSIONS option in the 

ITEM LISTING AREA to have the program surface the respective folder.  

 Enter the following: 

LABEL:    COL1 

TYPE:    Rectangle 

X-DIM:     12 in 

Y-DIM:     12 in 

 Click on the ADD button to add the entry to the list.  

9. From the Define menu, select Slaved Nodes, or simply click on the   tab and then select the 

SLAVED NODES option in the ITEM LISTING AREA to surface the respective folder.  

 Enter Wall Rx1 in the LABEL text boxes.  

 Select Rx from the DEGREE OF FREEDOM group.  

 Click on the ADD button to add the entry to the list.  

10. From the Define menu, choose Load Combinations, or simply click on the  tab to surface 

the respective folder.  

 Select SERVICE from ITEM LISTING AREA. 

 Click on the INSERT button. 

 Enter S1 for LABEL.  

 Enter 1.0 for CASE A and CASE B.  

 Click the INSERT button. 

 Enter S2 for LABEL.  

 Enter 1.0 for case A, Case B and Case C.  

 Click the INSERT button. 
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 Enter S3 for LABEL and 1.0 for Case A and Case C.  

 Select Ultimate from ITEM LISTING AREA.  

 Click the INSERT button. 

 Enter U1 for LABEL and, 1.4 for CASE A. 

 Click the INSERT button. 

 Enter U2 for LABEL and 1.2 for CASE A, 1.6 for CASE B. 

 Click the INSERT button. 

 Enter U3 for LABEL and 1.2 for CASE A, 1.0 for CASE B. 

 Click the INSERT button. 

 Enter U4 for LABEL and1.2 for CASE A, 0.8 for CASE C. 

 Click the INSERT button. 

 Enter U5 for LABEL and 1.2 for CASE A, 1.0 for CASE B, 1.6 for CASE C. 

 Click the INSERT button. 

 Enter U6 for LABEL and 0.9 for CASE A, 1.6 for CASE C. 

 Click the INSERT button. 

 Enter U7 for LABEL and 1.2 for CASE A, -0.8 for CASE C. 

 Click the INSERT button. 

 Enter U8 for LABEL and 1.2 for CASE A, 1.0 for CASE B, -1.6 for CASE C. 

 Click the INSERT button. 

 Enter U9 for LABEL and 0.9 for CASE A, -1.6 for CASE C. 

 Click the INSERT button. 

 Uncheck the Include SELF-WEIGHT IN CASE A for all combinations box. 

11. From the Define menu, select Loads, or simply click on the  tab to surface the respective folder 

 Select CONCENTRATED from the ITEM LISTING AREA.  

 Click on the INSERT button. 

 Enter PD1 for LABEL. 

 Enter A for the LOAD CASE and enter the following: 

Pz = -50 kips 

Mx= 0 k-ft 

My= 0 k-ft 

 Repeat the 3 steps above to enter the remaining two dead loads shown in the table below (PD2 and 

PD3). 

Case Label Pz Mx My 

A PD1 -50 0 0 

PD2 -47 0 0 
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PD3 -94 0 0 

 Click on the INSERT button 

 Enter PL1 for LABEL. 

 Enter B for the LOAD CASE drop-down list and enter the following: 

Pz = -35 kips  

Mx= 0 k-ft 

My= 0 k-ft 

 

 Repeat the 3 steps above to enter the remaining two live loads shown in the table below (PL2 and 

PL3). 

Case Label Pz Mx My 

B PL1 -35 0 0 

PL2 -26 0 0 

PL3 -52 0 0 

 Click on the INSERT button  

 Enter PW1 for LABEL.  

 Enter C for the LOAD CASE drop-down list and enter the following: 

Pz = -10 kips 

Mx= 5 k-ft 

My= 0 k-ft 

 Repeat the 3 steps above to enter the remaining three wind loads shown in the table below (PW2, 

PW3, PW4, PW5, and PW6).  
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Case Label Pz Mx My 

C PW1 -10 5 0 

PW2 -16 0 0 

PW3 -23 0 0 

PW4 -20 0 0 

PW5 -17 0 0 

PW6 -4 0 0 

Assigning Properties  

12. From the Assign menu, select Thickness to surface the respective folder. 

 From the ITEM LISTING AREA, select THICK1. 

 In the GRAPHICS/INPUT AREA, marquee select the region (-1,39) – (23, -1) to apply the selected 

thickness to that part of the footing. 

 Marquee select the region (27,21) – (49, -1) to apply the selected thickness to that part of the footing. 

Notice how the selected regions are redrawn in red: 

 

 From the ITEM LISTING AREA, select THICK2. Note that the regions defined in the previous steps are 

redrawn in cyan, indicating that they have a thickness other than THICK2.  

 In the GRAPHICS/INPUT AREA, marquee select the region (21,39) – (29, -1) to apply the selected 

thickness to that part of the footing. 

Note: To see the assigned element and node numbers, from the Define menu, select Grid, and once 

the GRID folder surfaces, double click on PREFERENCES. 

 From the Assign menu, select Soil or click on the SOIL option in the ITEM LISTING AREA. 

 Expand the SOIL listing in the ITEM LISTING AREA and select SOIL1. 
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 In the GRAPHICS/INPUT AREA, marquee select the region (-1,39) – (29, -1) to apply the selected soil 

to that part of the footing. The selected elements are redrawn in red.  

 Select SOIL2 and in the Graphics / Input Area, marquee select the region (27,21) – (49, -1) to apply 

the selected soil to that part of the footing. The selected elements are redrawn in red.  

13. From the Assign menu, select Concrete or click on the CONCRETE option in the ITEM LISTING AREA.  

 Expand the CONCRETE listing in the ITEM LISTING AREA and select CONC1.  

 In the GRAPHICS/INPUT AREA, marquee select the region (-1, 39) – (49, -1) to apply the selected 

concrete to the entire footing. The selected elements are redrawn in red.  

14. Repeat the step above using the Assign / Reinforcing Steel and Assign / Design Parameters commands 

to apply STEEL1 and DC1 properties to the entire footing.  

15. From the Assign menu, select Column Dimensions or click on the COLUMN DIMENSIONS option in the 

ITEM LISTING AREA.  

 Expand the COLUMN DIMENSIONS listing in the ITEM LISTING AREA and select COL1.  

 In the GRAPHICS AREA, click on each of the following nodes (2,2), (25,2), (46,2), (2,18), (46,18), 

(2,36), and (25,36). Column sections are shown indicating columns are assigned.  

16. From the Assign menu, select Slaved Loads or simply click on the tab to surface the respective folder. 

 In the ITEM LISTING AREA, expand the SLAVED NODES item to display WallRx1, then select it.  

 In the GRAPHICS AREA, marquee select the region (24,25) – (26,15). The five nodes within the 

selected region are redrawn in red. These nodes are assigned to the slaved nodes group WallRx1.  

17. From the Assign menu, select Nodal Loads or simply click on the tab to surface the respective folder. 

 

 In the ITEM LISTING AREA, expand Case A and then expand CONCENTRATED to select PD1. 

 In the GRAPHICS AREA, click on each of the following nodes (2,2), (25,2), (46,2), (2,18), (46,18), 

(2,36), and (25,36). Small red squares are shown indicating loaded nodes. Note that it is important to 

assign column nodal load to the same nodes where columns are assigned in step 15 in order for 

punching shear to be calculated properly. 

 Select PD2 from the list box. In the GRAPHICS AREA, click on the nodes (25,16), and (25,24). 
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 Select PD3 from the list box. In the GRAPHICS AREA, click on the nodes (25,18), (25,20), and 

(25,22). 

 In the ITEM LISTING AREA, expand Case B and then expand CONCENTRATED to select PL1. 

 In the GRAPHICS AREA, click on each of the following nodes (2,2), (25,2), (46,2), (2,18), (46,18), 

(2,36), and (25,36). 

 Select PL2 from the list box. In the GRAPHICS AREA, click on the nodes (25,16), and (25,24). 

 Select PL3 from the list box. In the GRAPHICS AREA, click on the nodes (25,18), (25,20), and 

(25,22). 

 In the ITEM LISTING AREA, expand Case C and then expand CONCENTRATED to select PW1. 

 In the GRAPHICS AREA, click on each of the following nodes (2,2), (25,2), (46,2), (2,18), (46,18), 

(2,36), and (25,36). 

 Select PW2 from the list box. In the GRAPHICS AREA, click on the node (25,16). 

 Select PW3 from the list box. In the GRAPHICS AREA, click on the node (25,18). 

 Select PW4 from the list box. In the GRAPHICS AREA, click on the node (25,20). 

 Select PW5 from the list box. In the GRAPHICS AREA, click on the node (25,22). 

 Select PW6 from the list box. In the GRAPHICS AREA, click on the node (25,24). 

Solving  

18. From the Solve menu, select Execute to surface the SOLVER folder. 

 Enter 10, 11, 50, 0, and 0 in the text boxes and choose the MAXIMUM MOMENT WITHIN AN 

ELEMENT option. 

 Click on the RUN button. 

 The spMats Solver window is displayed and the solver messages are listed. After the solution is 

done, focus will automatically be passed to the VIEW RESULTS folder. 

 

Viewing and Printing Results  

19. To view the results in text format, use the Solve / View Results command. Selective printing may be 

done from the displayed box or using the File / Print Results command. 
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20. To view the results in graphical format, use the Solve / View Contours command. A printout of the 

screen may be obtained using the File / Print Screen command. 

 

Sample Results for Example 2 

 

Service Envelope Displacement Contours for Example 2 
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Service Pressure (S1) contours for Example 2 

Soil pressure values in the contour view above differ along dissimilar soil boundaries. See the Winkler’s 

Foundation section in chapter 2 for more information. 

 

Element Numbering for Example 2 
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Node Numbering for Example 2 
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Import File Formats 

Grid, load, and load combination data may be imported from a text file. The import file must be saved in pure 

ASCII (text) format. Data fields on each line should be separated by spaces or TABs. Comments or blank 

lines should not be placed within the import file. The first line of each text file must be the unique keyword 

associated with the input. 

Grid Data: 

GRID 

N_X 

X_1 

X_2 

… 

X_N_X 

N_Y 

Y_1 

Y_2 

… 

Y_N_Y 

Where: 

 GRID = keyword required 

 N_X = number of X-gridlines 

 X_i = i’th X-gridline coordinate with i=1 to N_X 

 N_Y = number of Y gridlines 

 Y_j = j’th Y-gridline coordinate with j=1 to N_Y 

Load Data: 

LOADS 

N_P 

Label_P_1 Case_P_1 Pz_1 Mx_1 My_1 

Label_P_2 Case_P_2 Pz_2 Mx_2 My_2 

… 

Label_P_N Case_P_N Pz_N Mx_N My_N 

N_A 

Label_A_1 Case_A_1 Wz_1 

Label_A_2 Case_A_2 Wz_2 

… 

Label_A_N Case_A_N Wz_N 

Where: 

 LOADS = keyword required 

 N_P = number of point loads 

 Label_PL_i = label of the i’th point load, with i-1 to N_P 

 Case_P_S_i = name of the load case to which the i’th point is assigned 

 Pz_i = Pz force component of the i’th point load 

 Mx_i = Mx moment component of the i’th point load 

 My_i = My moment component of the i’th point load 

 N_A = number of uniform area loads 

 Label_A_j = label of the j’th uniform area load, with j=1 to N_A 

 Case_A_j = name of the load case to which the j’th uniform area load is assigned 

 Wz_j = Wz force component of the j’th uniform area load 

Load Combination Data: 

COMBINATIONS 
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Self 

N_C 

Label_CaseA Label_CaseB Label_CaseC Label_CaseD Label_CaseE Label_CaseF 

N_S 

Label_S_1 CaseA_S_1 CaseB_S_1 CaseC_S_1 CaseD_S_1 CaseE_S_1 CaseF_S_1 

Label_S_2 CaseA_S_2 CaseB_S_2 CaseC_S_2 CaseD_S_2 CaseE_S_2 CaseF_S_2 

… 

Label_S_N CaseA_S_N CaseB_S_N CaseC_S_N CaseD_S_N CaseE_S_N CaseF_S_N 

N_U 

Label_U_1 CaseA_U_1 CaseB_U_1 CaseC_U_1 CaseD_U_1 CaseE_U_1 CaseF_U_1 

Label_U_2 CaseA_U_2 CaseB_U_2 CaseC_U_2 CaseD_U_2 CaseE_U_2 CaseF_U_2 

… 

Label_U_N CaseA_U_N CaseB_U_N CaseC_U_N CaseD_U_N CaseE_U_N CaseF_U_N 

Where: 

 COMBINATIONS = keyword required 

 Self = 1 if self-weight is to be automatically included in Case A, 0 otherwise 

 N_C = number of load cases per combination (maximum 26, A through Z) 

 Label_Case_j = label of the j’th load case (j=1 to N_C), e.g. DEAD, LIVE, etc. 

 N_S = number of service load combinations 

 Label_S_i = label of the i’th service load combination, with i=1 to N_S 

 Case_j_S_i = factor assigned to j’th load case in the i’th service load combination with 

j=A to Z and i=1 to N_S 

 N_U = number of ultimate load combinations 

 Label_U_k = label of the k’th service load combination, with k=1 to N_U 

 Case_j_S_k = factor assigned to j’th load case in the k’th service load combination with  

   j=A to Z and k=1 to N_U 
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Conversion Factors - English to SI 

 

To convert from  To  Multiply by 

in. m (1000 mm)  0.025400 

ft m  0.304800 

lb N (0.001 kN)  4.448222 

kip (1000 lbs)  kN  4.448222 

plf (lb/ft)  N/m  14.593904 

psi (lb/in.2)  kPa  6.894757 

ksi (kips/in.2)  MPa  6.894757 

psf (lb/ft2)  N/m2
 (Pa)  47.88026 

pcf (lb/ft3)  kg/m3
  16.018460 

ft-kips  kN • m  1.355818 

Conversion Factors - SI to English. 

 

To convert from To  Multiply by  

m (1000 mm) in  39.37008  

m ft  3.28084  

N (0.001 kN) lb  0.224809  

kN kip (1000 lbs)  0.224809  

kN/m plf (lb/ft)  68.52601  

MPa psi (lb/in2)  145.0377  

MPa ksi (kips/in2)  0.145038  

kN/m2
 (kPa) psf (lb/ft2)  20.88555  

kg/m3
  pcf (lb/ft3)  0.062428  

kN • m  ft-kips  0.737562  
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Contact Information 

Mail:  StructurePoint 

 Customer Service  

 5420 Old Orchard Road  

 Skokie, IL 60077  

 USA  

  

Phone:  (847) 966-4357  

  

Fax:  (847) 966-1542  

  

Web: http://www.StructurePoint.org 

Sales: info@StructurePoint.org 

Support: support@StructurePoint.org 

Licensing: licensing@StructurePoint.org 

 

http://www.structurepoint.org/
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